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1 DBDOC Introduction

1.1 DBDOC 11.6

This manual describes the components in DBDOC 11.6, released November 2025.

1.2 What is DBDOC?

DBDOC builds a safe, read-only snapshot of your Harmony INFI 90® DCS system, presenting an
integrated view of the configuration, graphics and databases. From the first version handling CADEWS and
SODG graphics, DBDOC has evolved to include WinCAD®, Composer®, Conductor VMS®, Conductor NT®,
Process Portal B®, AutoCAD®, MicroStation®, supplementary text and even disparate control system
components, such as P&IDs, WonderWare®, Honeywell® and OSISoft PI®. More recently, support for 800xA
PG2, PGP and SPlus graphics has been added to DBDOC. Most recently, AC 800M system support was
added with DBDOC 11.5.

DBDOC is in many ways a cooperative project with our clients, users of ABB® Harmony INFI 90 systems. We
rely heavily on your feedback to enhance and improve the tools that we provide. Many of DBDOC's present
features have been developed as a direct result of client requests and feedback. G. Michaels Consulting Ltd
is working in cooperation with ABB to further the development of DBDOC.

1.3 Who Can Benefit From DBDOC?

Getting DBDOC into the hands of more people that use the ABB Harmony INFI 90® system will pay off with
easier and better execution of any tasks they have to do. This applies to many types of workers, including
technicians, engineers, planners, managers, trainers, safety and loss prevention personnel, students, interns
and operators.

1.4 How Does DBDOC Work?

The DBDOC snapshot, a single file, is like a custom website representing your system. It is an amazing
interface for troubleshooting and analysis. Every document and resource is cross-linked, and with the
DBDOC browser you can navigate using the intuitive point and click interface. Powerful search capabilities
give instant access to any part of your system. Built-in tools and analysis reports can help you eliminate
common misconfigurations and improve your system. The DBDOC compiler builds a representation of your
system in the form of a .dbdoc (previously .M14) file. This project file can be rebuilt regularly, and is viewed
using the DBDOC browser. Live data is fetched from your system and presented on the graphics and
configuration diagrams displayed in the DBDOC browser. All this is completely safe and read-only.
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1.6 How is DBDOC Used?

DBDOC meets a variety of needs for users of Harmony INFI 90® systems:

1. Troubleshooting: DBDOC is an unrivalled tool for system analysis and troubleshooting.

2. Documentation: Integrate notes, documentation, and error reports from any source into the system
snapshot. Tag names in the documentation are automatically cross-linked with the rest of the
system.

3. Development: Check the system, use Management of Change to keep on top of updates, use
DBDOC's error checks to catch problems, enjoy faster browsing of the configuration.

4. Commissioning and Checkout: Save time with DBDOC during the implementation of a new system
or subsystem.

5. System Simulation: See the configuration and use emulated CIU data. Manually walk through the
response to proposed inputs.

6. Training: Safely introduce new personnel to the configuration. Track through the logic from start to
end, or to the source.

7. Detection of Errors and Misconfigurations: Use DBDOC's Error Browser to view your errors and
eliminate potential problems.

8. Portable System: The DBDOC system snapshot is portable, and lets you view your system
remotely.
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9. NERC Compliant Live Data on Business LAN: DBDOC can provide a remote NERC compliant
view of your system complete with live data.
10. Collaboration Tool: With DBDOC you can annotate drawings and graphics and integrate notes,
making it easy to share
11. Console Upgrades: Use DBDOC to understand where various tags and fields are used.
12. System Audits: Check out the whole system in an easy, efficient and systematic manner.

1.6.1 DBDOC for Troubleshooting

DBDOC's unique point and click browser interface makes it easy to trace signals throughout your system.
Every resource is cross-linked and at your fingertips, making for efficient and effective troubleshooting. Live
data from your system is integrated into the DBDOC snapshot providing even more information for productive
troubleshooting.

DBDOC increases the number of people who can safely and effectlively troubleshoot routine system
problems. System experts can be freed up to focus on other tasks.

1.6.2 DBDOC as Documentation

DBDOC can integrate existing text and RTF documentation right into the system snapshot. You simply create
a documentation folder and tell the Build Wizard its location. You can also build in archived error files to
document fixes in your system.

DBDOC automatically links tag names mentioned in documentation into the system snapshot. This feature
allows the creation of important documentation useful in the operation and support of the system with no
extra effort on your part.

1.6.2.1 Uses of DBDOC for Documentation

DBDOC has been used by clients to enhance system documentation in a variety of ways, including the
following:

1. Alarm Documentation - Simply documenting an alarm tag with its name gets a link to it that people
can look up easily. Mentioning associated tag names, graphics and other documents will give you
links from the information about the alarm in question to other parts of the system.

2. Calculation Support - A simple document describing calculated values gives you a permanent
record of how the values are calculated and the tags that are involved. This can serve you well when
changes are contemplated by preventing the inadvertent elimination of tags that are in use in more or
less obscure ways.

3. Logs and Reports - Creating a text / document form of data logs and reports that mention the
tagname gives you instant documentation to assist in tracking down bad values.



1.6.2.2 Optional Documentation Extensions to DBDOC

DBDOC can also be used for block number linked documentation. If you have tables of information that
mention block numbers for specific reasons, we can optionally (at additional cost) extend DBDOC to compile
the documentation with links on the blocks. To do this, we need a Loop / PCU / Module context. This can be
created easily by folder names or document names, or by the inclusion of definitive statements in the
document.

1.6.3 DBDOC During Development
DBDOC can be used to support development work in a rapidly changing environment in a number of ways:

e With DBDOC, you can build a new snapshot of your system nightly, and keep up with changes in
configuration.

e Use DBDOC to browse the logic instead of Composer or WinCAD.

¢ Use DBDOC's powerful Management of Change capability to monitor daily changes.

e Use DBDOC's error-checking capabilities to catch problems before you compile modules.

1.6.4 DBDOC for Commissioning and Checkout

If you put DBDOC to use at the right place at the right time, it will help support the implementation of a new
system or subsystem. People that have used it this way have been enthusiastic in its praise. It should be
possible for a project to be done better, cheaper and faster using DBDOC.

1.6.4.1 Experiences with DBDOC for Commissioning and Checkout

DBDOC has been widely used as an aid to the commissioning and checkout process. The following are the
experiences of several sites:

¢ Hibernia Oil Platform, Newfoundland, Canada - Our first implementation. They claimed that
DBDOC saved them one month in startup time in a multi-billion dollar project.

e Aluminum Partners of Jamaica, Nain, St. Elizabeth, Jamaica - In this case, DBDOC was actually
purchased before the INFI 90 system. DBDOC was used to explain the methodology implemented at
a partner aluminum plant using INFI 90.

e Yallourn "W" Power Station, Yallourn, Victoria, Australia - DBDOC was used over a number of
years as this plant was implemented unit by unit.

1.6.5 Using DBDOC with a Simulator

DBDOC is a powerful aid in simulation projects as you are able to see the logic. Simulations that include
emulated CIU support gain a great deal from its use. This topic has significant potential for application in
many systems:

¢ Before you download a new or changed module, build it in DBDOC.
e See how typical live values look in your new logic.



e Use DBDOC's error-checking and nitpicking to find and fix problems before they're online.

I Note: This capability is based on the existence of a simulation system such as TRAX that uses a ClU
style interface to logic that gets valid block values.

1.6.6 DBDOC as a Training Tool

DBDOC's read-only unified presentation of the consoles and configuration make it a powerful, safe, and
easy-to use training tool for new personnel ranging from operators to engineers. Other training-friendly
features include:

e Built-in help for function codes.

¢ A flattened view of the databases to make it possible to become more familiar with tags in the
system.

e Unparalleled support for signal tracing in order to become familiar with a system.

1.6.7 DBDOC for Error Detection

DBDOC checks your system for hundreds of types of errors and misconfigurations, with more added in each
update. In addition to actual errors, ambiguous non-error situations in your system such as extra wires,
constant blocks in ladder logic and unused tags are reported. Usually these non-errors cause no trouble, but
sometimes they can mask real problems.

DBDOC makes it easy to clean up your system, identifying undefined tags, tags with no source, missing or
out of order adapted blocks, graphics that cannot be triggered by the operators, and hundreds of other
misconfigurations and potential issues of varying severity.

DBDOC can make it possible to find parts of the logic that are unused. If you walk through the AO/L and
DO/L blocks, for example, you will find a subset that are not used. If you also find that they are not alarm
points, you might choose to re-evaluate the logic that creates them. Similarly, tags often become unused
without being removed.

The DBDOC Error Browser, part of Hyperview, allows you to walk through these errors, automatically display
error locations in Hyperview, filter, group, and sort errors in various ways, and hide or mark off errors as
"reviewed" so you don't have to be repeatedly checking the same set of errors once you have reviewed them
once. You can even share the process of reviewing errors, with error flags set by others automatically
displayed in the Error Browser.

1.6.8 DBDOC as a Portable System

DBDOC enables you to put a copy of your system on your laptop so that you are able to:

e Troubleshoot from home
e Support the system when you are on the road
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e | aptops, notebooks, and tablet PCs, coupled with wireless LANSs, give you the ability to put DBDOC
out in the field, far from AC power and networks and use DBDOC anywhere in your plant for
troubleshooting and other analysis.

e With a WAN or dial-in, you can even monitor live data remotely.

¢ DBDOC allows you to do a static analysis of you system anywhere, offline.

The Serial Port Module is a relatively inexpensive way to get realtime data directly to your laptop at a PCU.
We went to the trouble of marking data that comes from another PCU in blue so you do can see values you
cannot get directly in that PCU.

1.6.9 DBDOC for NERC Compliant Live Data on Business LAN

DBDOC allows you to safely troubleshoot, perform system analysis, and train support staff on your business
LAN, as well as read-only access to your system, at home, on courses, and in other parts of the plant. For
total NERC compliance, a relay server can be used to pass live data via an intermediate LAN.

1.6.10 DBDOC as a Collaboration Tool

DBDOC can be used as a collaboration tool in many ways. It can be used to:

¢ Send your consultants a copy of your system as built.
e Mark up your system with annotations and bookmarks.
e Share your annotations and bookmark files with your colleagues via e-mail.

1.6.11 DBDOC for Console Upgrades

With DBDOC you are able to build your old console and new console together in a single project. You can
then use DBDOC's Audit Window feature to verify that the new graphic accesses the same tags as the old
one.

1.6.12 DBDOC for System Audits

DBDOC gives you unprecedented capability to check things easily. When you have something to do, just
think of the old way that you had to do it, before DBDOC. For example, one client told us that a significant
safety audit was completed by an engineer in ten days instead of the estimated thirty days.

DBDOC allows you to walk through all function blocks of particular types to check them. You can check
parameters, tag names, documentation that should be linked and a multitude of other things. This capability
extends to checking ABB software revisions directly by walking through the blocks with a particular function
code.

The Audit Window allows you to look at the blocks and tags being used on graphics or CAD/CLD sheets.
Sometimes, this shows incorrectly entered data. Asserting the hotspots (Ctrl+Tab) is a useful feature in
looking for "dead spots" on graphics.



2 Hyperview Browser

2.1 How to run Hyperview, load a project file, and get help

DBDOC organises all your INFI 90 documents into a single package to give you fast, easy, read-only access
to the information you need to do your job. Hyperview is the browser that navigates through this view of your
system.

2.1.1 How to Run Hyperview

2.1.1.1 Starting Hyperview from a desktop shortcut

Usually Hyperview users are provided with a desktop Hyperview shortcut, allowing Hyperview to be
maintained in a central location accessible to many users. To run Hyperview, double click on the shortcut.
The last project file viewed will be automatically loaded.

2.1.1.2 Starting Hyperview from the Start Menu

If Hyperview is installed directly on your, machine, access it via the Start menu - under Programs look for
either a GMCL DBDOC or GMCL DBDOC Hyperview folder and click on the Run Hyperview option.

2.1.1.3 Launching an additional Hyperview window

You can also launch a new Hyperview window by selecting the New Window option from the File menu
inside of Hyperview. This will launch another copy of Hyperview viewing the same project and topic that you
are currently viewing. The new copy will inherit the same command line parameters as the copy that
spawned it.

2.1.1.4 Advanced: Running Hyperview from the command line

Command Line Options:

You can launch Hyperview via the command line. You may specify the name of the project file to open, as
well as, optionally, a particular document within the project to display when it first opens up. You may also

append additional optional arguments.

The command line takes the following form:

"<Installed program_location>\hyperview.exe"
<dbdoc file>
</document_switch=document_name>

</additional_optional_switches>

In practice this will take one of three forms:



Specifying a general document to open:

"<Installed program_location>\hyperview.exe"
<project file>
</doc=document_name> </type=document_type>

</additional_optional_switches>

Specifying a block whose source in the configuration will be displayed:

"<Installed program_location>\hyperview.exe"
<project file>
</block=block_specification>

</additional_optional_switches>

Specifying a tag whose source in the configuration will be displayed:

"<Installed program_location>\hyperview.exe"
<project file>
</tag=tag_name>

</additional_optional_switches>

Command line arguments:

e <project file> is the location and name of the .dbdoc (previously .M14) file to open.
¢ In lieu of an actual filename, you can use the asterisk (*) wildcard to open the newest project
file in the location specified.
+ If no filename is present, Hyperview will open the last project file that you were viewing.

¢ </doc=document_names> is the name of the document (without suffix) to open.

-- document_switch is one of the following arguments followed by the document_name (do not include the
file extension in the name):

Argument Explanation Example
/doc Specify a document to open. The optional /type switch /doc="G1WATER"
specifies the document type to be opened. The first /type=graphic

document (of the specified type) that has a name with a
leading substring that matches the string specified in /doc
will be opened. If /type is not specified, then the first
matching document of any type will be opened.

Strictly speaking, it is only necessary to specify /type in
cases of document name ambiguity. A wide variety of
types, such as graphic, cad, dxf etc. can be specified.
See Launching Hyperview from the command line in
the Hyperview Reference Guide for complete




information.

/tag="AMD-108" (Note:
This will bring up the tag
index in the Table of
Contents panel and the
CAD or CLD source, if it
exists, in the content pane.)

/tag Tag Name

/block="Module 1,1,1 Block
1" (Note: The index pane
should show everywhere
this block is referenced.
The content pane will
display the CAD or CLD
sheet source of the
specified block.)

/block Database record

2.1.2 How to load a project file
2.1.2.1 Opening a specific project file
To open a different project file follow the following steps:

1. Go to the File menu and click Open.

2. A standard Windows browse dialog box will open.
3. Navigate to the location of the file.

4. Click Open.

2.1.2.2 Opening a recent project file

You are also able to navigate to the File menu and click the Recent Project Files selection to pick a project
file from the last twelve files that were viewed.

The name of the last viewed project file is now stored in the registry. When Hyperview is run from the Start
button, it will be loaded with the last project viewed. Hyperview also stores the names of the last twelve
viewed project files and lists them in the Recent Project Files option under the File menu. This allows for
quick navigation between recently viewed project files.

2.1.2.3 Advanced: Opening the most recently built project file

Shortcuts to Hyperview can specify a wildcard project file specification (i.e., containing *). Hyperview opens
the newest file that matches the wildcard specification. The advantage of using wildcards like this is that you
do not have to rework your shortcuts with each new build and you can use the automatic renaming technique
in BuildPlus to archive your built project files.



2.1.2.4 Advanced: Associating project files with Hyperview in Windows

To make Hyperview open when you double-click a project file, you can associate the project file type (.dbdoc,
previously .M14) with Hyperview in Windows by following the steps below:

. Go to the Start menu, click on Control Panel, locate the Folder Options icon and double-click on it.

. Once the Folder Options window is open click on the File Types tab.

. Click the New button below the Registered File Types.

. In the File Extension box enter dbdoc as the File Type.

. Once it is added click the Change button below the File Types box.

. Choose the select the program to open the file from a list selection.

. Browse to C:\Program Files\GMCL\DBDOC\Programs and select hyperview.exe as the
program to open the file.
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If you are using Windows 11, you may need to do the following steps:

. Go to the Start menu and click on settings.

. Select Apps and then default apps.

. In the search bar under "Set a default for a file type or link type" type .dbdoc.

. Click on the DBDOC file option and choose Hyperview from the listed apps. If Hyperview does not
appear, you will need to scroll to the bottom, select "Choose an app on your PC", and then select
the hyperview.exe in your install location (usually program
files(x86)\GMCL\DBDOC\Programs\hyperview.exe)
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2.1.3 Help and Documentation
2.1.3.1 How to access the built-in help documentation

The Contents, Index, or Search for Help on the Hyperview Help menu will launch the DBDOC compiled
help. Selecting any one of these will launch the DBDOC compiled help, opened on the appropriately named
tab. The help file contains information on how to use BuildPlus, Hyperview, and CIUMon, appendices on
other programs and components, and our FAQ (Frequently Asked Questions) with useful information about
builds, set-ups or other problems you may encounter.

2.1.3.2 Help and tutorials on the GMCL website

Go to GMCL website on the Hyperview Help menu will launch Internet Explorer and take you to the Help
page on the GMCL website. There you can access all the same information as in the built-in help, as well as
interactive tutorials, user guides, and other documentation.

2.1.3.3 Finding the version of Hyperlink that built the current project file

About the build and project file on the Hyperview Help menu will bring up a dialog box that contains

information about the current project being viewed - the version of hyperlink that was used to build it and
when it was last built.
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2.1.3.4 Figuring out what version of Hyperview is running

About on the Hyperview Help menu contains the following information about the version of Hyperview
currently running:

e Hyperview version

¢ DBDOC Kit Version

e Winsock / No Winsock

¢ Mode (user or system)

e Command line used to launch Hyperview

2.1.3.5 Other ways of getting help
You may also click on various items to get more information. If it is a dialog box that you need more

information on, use the associated contextual help. Click the Help button in the upper right hand corner of
the dialog box and then click on the desired item to see a description.

11



2.2 Guide to basic navigation in Hyperview

2.2.1 Panes in Hyperview

The Hyperview browser shows two panes, or display areas. The pane on the left (or top) is called the index,
or Table of Contents pane. It is used for indexes and summaries of information. The pane on the right (or
bottom) is called the content, or topic pane. It is generally used to display documents and graphics, although
certain types of indexes and reports can also be displayed there.

2.2.1.1 Specifying the pane orientation

You can set Hyperview up so that the index pane can be located at the left or top while the content pane will
be located on the right or bottom respectively.

To change the orientation of Hyperview, click one of the following buttons in the toolbar:

They will produce the following results:

Sample

Condudior MT Graphics |
ATRATION, TANEL LTALL OVILATE, newname m b

BOWTR T ALARLUS |m

Sample
Conductiar HT

Craphics
ARRATION, TANES, STAGL

i s = 1 1]
E

=

=
e
i Fi

You can use the following menu options or commands to change the view from a menu or shortcut
key:

¢ Select Change Pane Orientation from the View menu.

e Select the View from the drop down list on the View tab in Options.

e Position the cursor on the border until it becomes the split cursor and drag the cursor to the view that
you would like.

¢ Press J on the keyboard or select Split Adjust from the View menu to get the split cursor.

¢ Adjust the view to full screen by pressing F on the keyboard, selecting Full Screen from the View
menu or double-clicking the border between the two panels.

¢ Drag the borders between the index and content panes until the index pane disappears.

Your viewing preferences are stored so that each time Hyperview is launched it will open to your last used
settings.

The settings it saves are:

e Size of the Hyperview window
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¢ Position of the window
e Size of index and content panes
¢ Classic or Treeview Table of Contents

2.2.2 Index pane

When you first start Hyperview, the index pane provides a view of the Table of Contents, a summary of all
the content contained in your project file.

2.2.2.1 Displaying the Table of Contents

To display the general Table of Contents:

® Click the Table of Contents toolbar button El
® ORpress C

* OR on the Go menu, click Table of Contents.
2.2.2.2 Switching between Classic and Treeview Table of Contents
There are two ways of displaying the Table of Contents. The first view is Classic View. It provides a
detailed view of your build content, but you generally have to scroll down a long way to get to what you want.
Treeview is a compressed, collapsible/expandable, easy-to-use overview, similar to Windows Explorer.

To switch between views for the Table of Contents:

® Press Ctrl+T.
¢ OR on the View menu, click Table of Contents as Tree.

To collapse the open nodes in the tree view table of contents:

*PressC.

® OR click the Table of contents toolbar button E

The following are examples of the the Classic (left) and Treeview (right) table of contents.
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2.2.2.3 Clicking on hotspots in the index pane

Some of the items in the index pane are hotspots, or hyperlinks (indicated in blue). In general, clicking on a
name-of-document hotspot in the Table of Contents causes that document to be displayed in the content
pane below or on the right. The exception is when the item in the index pane is the name of another index.
Clicking on a name-of-index hotspot in the Table of Contents will cause the new index to be loaded into the
index pane. Hyperview indexes will be discussed in more detail later.

Rarely, the hotspot in the index pane is a link to an external document, i.e. one that is not built into the
project file. When this is the case, a "proxy" document (with a title and link to the "real" document) is
displayed in the content pane. Clicking on the link in the proxy document causes the external document (e.g.
a PDF file with function code documentation) to be opened in your default PDF viewer application.

2.2.2.4 Index navigation

* Go to Next/Previous Topic

+ Go to the next/previous topic in the browse sequence.

+ This is dependent on which side the focus is on.

+ Use B and Shift-B on the keyboard or select from the Go menu.
® Go to Next/Previous Index link

¢ In an index, go to the next/previous hyperlink in sequence.

+ Use L and Shift-L on the keyboard or select from the Go menu.

2.2.3 Content pane
The content pane is where documents such as Operator Graphics, CAD/CLD diagrams, reports, text
documents, Tag and Trend Database entries, and other resources are displayed. These documents

generally contain hotspots, or hyperlinks. Clicking on different sorts of hotspots will have different effects in
the Hyperview browser, depending on the type of hotspot. Some link directly to other documents, while
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others represent blocks and allow signal tracing.

2.2.3.1 Displaying hotspots

There are typically many hotspots on a document in the content pane. When you move the mouse over a
hotspot, the cursor will change to a "pointing finger" shape. You can also highlight all the hotspots on a page
by pressing Ctrl+Tab or selecting Hotspots on the Highlight menu. You can also hover over a hotspot to
see a brief description in a tooltip.

2.2.3.2 Clicking on a hotspot to see all the uses of a value

Many hotspots represent a block or tag value. Clicking on a block or tag hotspot will cause all the places the
block or tag is used to be displayed in the index pane.

Block Use Index
Module 1,20,02 Block 3366
(WGB1-FLM-10250) WASTE
CAS BRMR 1 FLAME ON

DOJL: Digital Exception

\
Report [FC45] \ '.
W

1 190demod [Tag Database]

1".| 'l'l'E'l-FLM- 10250 Medule 1,20,02 EDL 3366
1 Tatk MORY-FLE. 350 (U I

2 12002L4C.CAD
2.1 Source (Exception report value)
3 GAS_STORAGE_AMD_COMPRESSION

Clicking on a block hotspot like this one

causes all the uses of the block to

appear on the index pane

Clicking on the value on the right brought up all the places in the system that that block is used, both as a tag
name and as a block. In this example, the selected block appears in the tag definition, a CAD/CLD
configuration sheet, and on this graphic. All this information is right in front of you.

2.2.3.3 Double clicking on a hotspot to go to the source of a value

Most hotspots are associated with blocks in the configuration. Double click on any block-hotspot to display
the block source in the configuration.

2.2.4 Focus for the active window
Focus is shown by the color border on the index or content pane and shows which side of the browser you

v
are working in. It affects printing and the Next Topic and Previous Topic EI buttons. To set focus in a
particular pane, click the mouse on some white space (where the cursor remains an arrow) in that pane.
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2.2.5 Setting a "Home Page" for your index and content panes

You can specify home pages for your index and content panes. If none are specified, then the Home button
will return you to the classic opening view.

2.2.5.1 Setting your "Home Page" to the current document
You can easily set your homepage to a topic that is currently displayed in the Hyperview browser.
¢ Right-click on a topic. In the popup menu that appears, you can easily set the home button to call up
the desired page using Make This Topic My Index Pane Home Page (if the index pane has focus)
or Make This Topic My Content Pane Home Page (if the content pane has focus).
Your home pages are saved in your user logon (in the same location as your annotation, bookmark and

history files). They will stay intact when the DBDOC files are updated and the project rebuilt. Typical content
pane home pages are overview graphics that get you anywhere in the plant in one click.

Stage I Ras Screw Pump Overview

2.2.6 Scrolling

I Note: As of DBDOC 11.3, Hyperview supports two different scroll and zoom modes. The original mode
(can be selected as Legacy scroll & zoom mode in the View tab of the Options Dialog) supports scrolling
via the scrollbar and scroll wheel. The new mode, now the default, allows scrolling by dragging, and the scroll
wheel zooms. Holding down the Ctrl key will temporarily enable the non-selected mode.
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2.2.6.1 Default mode scrolling

By default, graphical documents can be scrolled with the scrollbar, or by dragging with the mouse. The scroll
wheel now zooms graphical documents. Text documents can be scrolled with the scrollbar or with the scroll
wheel.

2.2.6.2 Legacy scroll & zoom mode scrolling

When Hyperview is in Legacy scroll & zoom mode, all documents can be scrolled with the scrollbar or
scroll wheel. Dragging does not scroll, but rather zooms on graphical documents.

Note that the unselected mode can be enabled transiently by holding down the Ctrl key. So, you could

access drag-panning even in Legacy scroll & zoom mode by pressing Ctrl, and then dragging with the
mouse.

2.2.7 Zooming

I Note: As of DBDOC 11.3, Hyperview supports two different scroll and zoom modes. The original mode
(can be selected as Legacy scroll & zoom mode in the View tab of the Options Dialog) supports
"rubber-band" zooming on graphical documents. The new mode, now the default, enables scroll wheel
zooming. Holding down the Ctrl key will temporarily enable the non-selected mode.

2.2.7.1 Default mode zooming with the mouse

Place the mouse above the spot you wish to zoom in or out on, and scroll up with the scroll wheel to zoom in,
or scroll down to zoom out.

2.2.7.2 Legacy scroll & zoom mode zooming with the mouse

Click and drag a rectangle in the content pane around the area that you want enlarged. When you have
finished dragging, Hyperview will centre your selection in the pane, magnified to fit.
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2.2.7.3 Zooming with toolbar buttons or the keyboard

® To zoom in to double the zoom level, click the Zoom In button or press +
® To zoom out to half the zoom level, click the Zoom Out button or press -

*To toggle between full view and the previous zoom level, click the Zoom Toggle button EI or press
y4

e Zoom functions are also available through the View menu.
2.2.7.4 Manually setting the magnification factor

You can manually set the magnification factor for any graphical topic (graphic, CAD/CLD sheet and AutoCAD
drawing).

¢ Right click on the drawing and select Set Zoom Factor from the popup menu.
¢ Enter the zoom factor you wish to apply to the topic.

Set foom Factor [-"‘:hj
Please enter the desired zoom factor: 150 oy,
b 2
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2.2.8 Using browser history to return to previously viewed documents
Hyperview history is similar to that of other browsers like Internet Explorer.
Going backward and forward in the browser history:
® Click the Go Back button or Go Forward button to go to
the previous or next item.
e Activate the drop down menu for the forward and backward lists by clicking on the arrow to the right
of the button and selecting the desired item.

¢ The last document viewed is retained across builds. This is stored in <project_name>.hst in the
same location as your annotation, bookmark and home page files.

2.2.9 Using bookmarks for quick access to pages of interest

Flag special pages for quick access! These can be added to any document.

To bookmark a topic:

® Click on the Add Bookmark button on the toolbar.
e OR Choose Define under the Bookmark menu

Add Bookmark ﬁ
Hyperview wil add the current topic to your bookmarks menu. [ o«
Name: | Operators Graphics: G26.DR. (INT PRESSURE) ] Cﬂfﬂ*[

* OR Press Ctrl+D to add the document directly. This option will add the document to the bookmark
list without bringing up the Add Bookmark dialog where you can edit how the text will read in the list.

Bookmark Message il-f__E-J

Bookmark Successfully Added
| oK

I Don't show me this again

Multiple bookmarks with the same name are not allowed. If you try to define a bookmark with a name that
already exists, Hyperview will bring up a message box to warn you of the duplication. It will give you the
option of editing the current bookmark name or canceling the operation.
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Using and managing bookmarks:

Bookmarks will be appended to the Bookmark menu as a new menu item. Select the desired bookmark from

the menu and jump to the corresponding topic. Edit or delete bookmarks by selecting the Manage option
from the Bookmark menu which will open the following window:

B Manage Bookmarks

Bookmarks

12 graphics

3 Function Cades by Mumber

I-.;__‘ Tag Index | Tags beginning with 2

F"'""Erception Reported Values with Significant Change

F"‘ Maodule 197,23,03 | Medule 197,23,03: Control Logic Document 1

[¥ Show System Bookmarks in Menu

Import Bookmarks | | : | Done

Bookmarks not only remember the document you were on, but the zoom factor, scroll position and hotspot
highlighting as well.

"System" bookmarks (green flag) can be built into the project file, and be seen by all users.

2.2.9.1 System bookmarks

As of DBDOC 11.6, a new type of bookmark has been introduced. These "System" bookmarks are built
directly into the DBDOC project file, and are thus distributed to all users sharing that file. The System
bookmarks can be created by the DBDOC administrator as part of the build process.
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2.3 Techniques for tracing inputs and outputs throughout your system

2.3.1 Overview of signal tracing in Hyperview
There are two basic ways to trace signals in Hyperview:

1. You can click on hotspots in in the content pane in order to display uses of the hotspot value in the
index pane. Clicking on a use in the index pane causes the document with the use in it to be
displayed in the content pane. This method of signal tracing requires that the index pane be visible,
so it cannot be used when the browser is in "full screen” mode. On the other hand, the list of uses of
a value is displayed in the index pane until you change it, and this list can be printed and perused at
leisure.

2. You can double-click or use the context menu on hotspots to jump directly to the source of a value
(bypassing the index pane), or to display a list of uses in the context menu that you can select from.
This method of signal tracing can be used even when the browser is in "full screen" mode with the
index pane not visible. The downside is that the index of uses of a value is only temporarily visible.

2.3.2 Tracing signals using hotspots and the index pane

Click on the Sour nt b
Block Use Index i e
Module 1,01,02 Block 182 (DS5PT115) the content pane.

1 101
1.1 '.-:.J' :
2 1010264A.CAD
2.1 Input 51 to block 1994 (

The index pane shows
all the uses of Block

182. Click on any use
Q: Test Quality [FC31]) / to display it in the

cantent pane.

2.2 Input 51 to block 1988 (H High/Low Compare [FC12])
2.3 Input 51 to block 1986 (H//L:%igh/Low Compare [FC12])
2.4 Input 51 to block 1966 (DEL PIDNPID Control (PV and SP) [FC19]) v
=i il
CIsI/fO AlL- &
o <o 2a O\ DALT302
63-10.04 ), : 3

Click on Block 182 in
the content pane to

— display the index of all r‘_.
H DSPT115 th I it i d Al
s4-10 .04 — | e places it is used. —

26-04.03 YELi340 N T e
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2.3.2.1 Tracing back to the source of a value
To trace a signal, use the follow steps and refer to the image below:
1. Click on an item of interest in the right side content pane
2. Click on item labeled source, in red in the index pane, if it exists, then click on an input to the block
newly highlighted in the Content pane
3. Repeat until you have traced back far enough.

Viewing live data on the fly:

e At any point, you can turn on live monitoring to check what the values are.

®If you use Slow Mode @ monitoring will stay on from document to document, and values will be
fetched whenever you change documents.

® In Continuous Mode monitoring, monitoring is automatically turned off when you go to another
document.

2.3.2.2 Finding and displaying the uses of a value

Simply click on any tag or block in either the content pane or the index pane. Its source and uses will be
displayed in the index pane. The source is always displayed in red. By default all uses are displayed in blue.

2.3.3 Tracing signals using Go To Use, Go To Source, and double-clicking on
hotspots

2.3.3.1 Jumping directly to the source of a value with Go To Source or double-click

The Go To Source feature is a powerful and natural feature that allows you to find the source of an value
without using the index pane at all.

There are two ways to use Go To Source:

¢ Double-click on an input on a CAD/CLD or block on a graphic
* OR Right-click on a point and choose Go To Source on the popup menu

Hyperview will automatically take you to the source of the input.
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Add Standard Inputs and Outputs to Watch Window (5ee Function Block Menu)
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[ Help about TSTQ: Test Quality [FC31]...
S Function Code Documentation (PDF)...
2 Search for "518" »
5 Copy "518"
2 Create Text Annotation for this Block
S Create Live Loop Annotation for this Block L4
g Add this Block to the Watch Window ¥
S
5

Show Live Function Graph for this Block

Go to Source: Module 1,01,02 Block 6085 (TSTQ: Test Quality [FC31])
Goto Use b
Go to Block Map

2.3.3.2 Jumping directly to a use of a value with "Go To Use" or double-click

To access any use of a block, right-click on the block's output or input and point to Go to Use, then click on
one of the block's uses. If you have recently navigated to the block using Go To Source, the block from
which you used Go To Source will be listed first.

T

5] [ E€ 58] | _____ ) ‘ [ECad]
—Slgl ADSL . I L F857 51l TREMD

1445 CHe Tu
Mgy albout SUMICE Suvener [2-Input) [FC1S) CHi TURBTHE

AMLGLS3

Seaech for “153" p Q] [FL38]

Eopy “1643° s L }mq &
Creste Text &nnctation for this Block :i\i‘

Creste Live Loop Annotstesn (or this Block A | | FL&]
Add thin Block 1o the Witch Windew 2 Wj—u..{ TREND }‘
hid Standad Inputs and Cagputs Bo Watch Window ([Se t ¥ M 2442
" s

Input 51 to block 1644 (AL Analog Exception Repart [FC30T)
Input 51 to Bleck 1645 (TREND: Ansleg Teend |FOSE])

Go bo Lise [:E'
Go to Block Map

You can also double-click on an output to go to a use. This will take you to a use of the block as follows:

1. If there is only one use, or only one high-importance use, you will be taken to it automatically.
2. If you have recently navigated to the block using Go To Source, you will be taken to the block you
used Go To Source from.
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3. Otherwise, a popup menu will appear to let you select a use.
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2.4 Full text, database, or title searches and search result navigation,
and finding coordinates

2.4.1 Searching

When you build an project file with DBDOC, Hyperview can search it to find almost anything.There are three
search options that you can use to find the information that you need:

Full Text Search
Database Search

I:I Topic Title Search

Just look for the Big Binoculars and move your mouse over them. The button will change to reflect the
last type of search that you did. Click on the button and the Search dialog will open to that particular type of

search.
2.4.2 Text and database searches

2.4.2.1 Using Full Text Search to search your system for a word or phrase

Search for any word or phrase throughout the entire project, or restrict it to certain types of documents. To
launch the Full Text Search utility, you can:

¢ Click the Search toolbar button , then click the Full Text Search tab

* OR Select Full Text Search from the Search menu

® OR Press Ctrl+F on the keyboard

¢ OR Select text in a document and right-click. Go to the Search For Selection option from the popup
menu that appears and choose Full Text Search.
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Search b4

Full Text Search | Database Search | Topic Title Search I
— Search phrase

I |
Wildcards: ¥ (any one character)
** (zero or maore characters)

¥ Match exact phraze
™ Match each search term Iﬂﬂﬂth' _ﬂ

% Find any search term " Find all zearch terms

Operatorz; AMD, OF, MOT [upper case required]
[uotes;  “find thiz exact phraze''

—Scope
[Froups;
i+ Al Topics *Group: Databases
. * Group: Graphics
" Cument Topic * Group: AC 800M Configuration
" Groups Group: Indices
Group: Missing Graphics
Group: Missing Symbol'Sub-model Re

— Results display
¥ Show Loop, PCU, Madule, Block
[ Show Number of Hits per Topic
¥ Show Group ¥ Show Pane [~ Show Hit Strings

Stop Search |

Search | Close

Multiple word search terms are automatically treated as if they are within quotes. For example, if you look for
the term condenser pump, you will only find documents with the word condenser followed by the word
pump. Documents that contain only one of the two words condenser or pump and documents where the
word condenser is not immediately followed by the word pump will not show up.

i~ Search phrase

|mndencser pUmp j

Wildcards: "7 (any one character)
™ (zero or more characters)

" Match exact phrase
&+ Match sach search term |mdlr LI
" Find any search term ' Find all search terms

Operators:  AMD, OR, NOT (upper case required)
Guotes: "find this exact phrase”

Match type drop-down list:
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e Match exact phrase: searches for "condenser pump"

e Match each term + exactly: searches for condenser AND pump

¢ Match each term + to the beginning of a word: searches for condenser* AND pump*
e Match each term + to the end of a word: searches for *condenser AND *pump

e Match each term + to any part of a word: searches for “*condenser* AND *pump*

D Note: The more wildcarding there is, the slower the search will be.

In Match each term mode, you can specify whether you wish search for ALL the terms, or ANY of the terms
by selecting either

¢ Find any search term
* ORFind all search terms.

I Note: The logical operators AND, OR, and NOT and parentheses can be used in Match each search
term mode. In Match exact phrase mode they will just be treated as ordinary text to match.

2.4.2.2 Using Database Search to find particular blocks or tags

A database search allows you to search the databases built into your project. To launch the Database
Search utility you can:

® Click or on the toolbar and select the Database Search tab
¢ OR Select Database Search from the Search menu

* OR Press Alt+D on the keyboard
¢ OR Select text in a document and right-click. Go to the Search for Selection option from the popup
menu that appears and choose Database Search.
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Search

Full Text Search Database Search | Topic Title Search

Enter text in amy box or boxes to find tags in the database.

Find tags with matching tag names
Example: ‘ail"in this booe will find all tags with ‘ail" in the tag name.

Tag Name: | =
How to match: |;.'.,|-q,r part of text ﬂ

Find tags by tag index

Tag Index: |

Find tags by Loop, PCU, Module or Block

Loop: | PCL: | Module: Block:

Find tags by teaxt

Example: tank’in this boo will find all tags with tank” in the tag
description or other database text.

Miscellaneous Text: | ﬂ

Results display
[v Show Loop, PCU, Module, Block
[+ Show Database

| Close

You can search by entering the tag index value, trend index value, tag name (or partial tag name) or any
combination of Loop, PCU, Module and Block number. You can select any previously entered tag names or
miscellaneous text from the drop down list. Miscellaneous text is very useful if you know part of the
description field of what you are looking for but none of the above information.

2.4.2.3 Setting search options for text and database searches

For both Full Text Search and Database Search:

e Show Loop, PCU, Module, Block columns shows these attributes of a result topic, where

applicable.

e Show Number of Hits per Topic shows you the number of times that your search item has shown

up in one document.

¢ Show Group shows you the category to which your hit document belongs.
e Clear Search Hits on the Search menu will remove all the highlight marks from the search results.
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For Full Text Search only:
e Show Hit Strings shows the context in which a hit occurs (i.e. surrounding text)
2.4.2.4 Viewing search results for text and database searches

After you do a text or database search, you will see the following search results dialog:

& [i190 dermno daily baild_20260430¢_w2026-04- 30- 102166 dbdoc] Search Results - 0O b

File

Searched for topics with the following text:
tank (match exact phrase)

170 hits found in 88 topes
Topic Title | oop| Pou| Modue| Bock|  Hits | Growp | Pane | Hit Strings -
All Lises of RUCM: Remote Control Memor.... 2 Main Funciion Block Index Left g B2FC 62BLK 352 244
Al Uses of RNGS: Rung [S-Input) [FC110] 2  Main Functon Block Index Left g 2B1FC 110 BLK 1124 X5
BATCH Files Batch Flles: JUICER 23 UNL... 2 Bakch Programs, Module 1... Right {MICE DAY TAMNC LEVEL): €
BATCH Files Batch Flles: STARCH COOK. ., 9 Batch Progroams, Module 1. Right  [Chok to show Hit Strings
BATCH Files Batch Flles: SUGAR STUFFE.. 10 Batch Programs, Module 1. Right {SUPPLY TAMK 1 AGIT.}; {2
EVAMTR. Ladder Frogram 4 Module 1,01, 14, Logic Left [Chok to show Hit Strings -
EVAMTR Ladder Program: Blod: 1124 1 Ladder Diagrams, Module .. Right Rung 281 BLK: 1124 X5-00:
EVAMTR Ladder Program: Block 1126 1 Ladder Diagrams, Module .. Right Rung 283 BLE: 1126 X5480:
EVAMTR Ladder Program: Blodk 352 1 Ladder Diagrams, Module .. Right FRung G2BLK: 352 24a-MS
EVAMTR Ladder Pragram: Blodk 356 1 Ladder Diagrams, Module .. Right Rung G6BLK: 356 2-M5
Exteption Reported Valees with Signific.. 5 Reports Right  [Click to show Hit Strings -
Moduls 1,01,02 Bock 1816 1 1 2 1816 2 Blodk Use Indices Left NTHL STORAGE TAMK LWL
Module 1,01,02 Bleck 1831 1 1 2 1831 2 Blodk Use Indices Left WASTER MEUTR TAMKLE
Module 1,01,02 Bleck 2031 1 1 2 231 2 Blodk Lise Indices Left WASTEHOLDUP TAMKLW
Modhuls 1,01,02 Block 2040 1 i 2 2050 2 Blodk Liss Indices Left WASTE HOLDUP TAMNKLE
Module 1,01,02 Block 2235 1 1 2 2735 2 Blodk Use Indices Left DEMIN WTRJCHNDS STRGT.
Pk ds 1 M AP Bk TR 1 i ] LERT 5 Bk § e Trakess 1=fF WASTE CTA Y Wunie
< »

r

™ Keep Doen Ga To E:q:-nrthoTsh'l Clage | Seardh Again |

¢ File: Gives you the option to Save the search results to a file (a default filename is automatically
supplied.)

e Topics Containing Search Key: Lists all the topics that met the search criteria. The list can be
sorted based on Topic Title, group or hit frequency. You can jump to a topic by double-clicking on it.

* Keep Open: Keep the dialog box open after going to a document rather than automatically closing.

¢ Search Again: Click to bring up the full text search dialog with all your previously specified search
criteria filled in to narrow down your search hits.

* Go To: Go to the currently selected topic in the list.

2.4.2.5 Displaying and stepping through search results using the Hyperview toolbar

There are a number of ways you can browse search results later, even after the Search Results dialog has
been closed.

® Use the Next Highlight IZI and Previous Highlight toolbar buttons to step through the search
results in the document you are looking at.

e Click the Search Results toolbar button to bring up the list of search results
® Use the Next Search Hit and Previous Search Hit toolbar buttons to step through the
documents that were found.

If no search hits were found, Hyperview will bring up an informational message box to let you know.
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Mo Search Results ot

Mo Matches

[ Don't show me this again

You can again choose to suppress this dialog from appearing the next time no matches are found by
checking the Don't show me this again option before dismissing the option.

Ej Note: If you click the box, when you search for something that is not found, you will simply see the search
box remain as you launched it when the hourglass disappears. You can then easily try the search in a
different way, but you have to realize that the search was done, but was unsuccessful.

2.4.3 Using the Topic Title Search to jump directly to a topic

This highly convenient search mode makes it very quick and easy to jump to a topic of interest. Simply start
typing the topic name. You will see a list of possible topics as you type. The more you type, the shorter the
list will get. Double-click on one of the results any time to display it in the browser.
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Search pod

Full Text Search | Database Search  Topic Title Search l

Type a word:
|water j

8 matching topics found for "water”

24A-M55-014 MILL WATER BOOSTER PUMP CONTROL
24B-M55-023 B-LINE SEAL WATER PUMP CONTROL
glwaterm [Conductor NT Graphics]

G46.DR (WASTEWATER TREATMENT 5Y5) [Graphics]

¥5-013 EVA RIVER WATER BOQSTER PUMP MOTOR OUTPUT
¥5-014 EVA MILL WATER BOOSTER PUMP MOTOR QUTPUT C
¥5-B23,EVE B-LINE SEAL WATER PUMP MOTOR QUTPUT COR

[~ Documents Only [v Keep Open

Go Ta | Close

To launch the Topic Title Search utility, you can:

® Click I:I or IEI on the toolbar and select Topic Title Search.
* OR Select Topic Title Search from the Search menu.

* OR Press Alt+T on the keyboard.
® OR Select text in any document and right-click. Go to the Search For Selection option from the
popup menu that appears and choose Topic Title Search.

Other useful tips by searching for title:
As you enter the document name, Hyperview narrows the scope of the match. Module LL,PP,MM Block
NNNN is a topic. NNNN will give you Conductor NT graphics by number. Select the document you want and

click the Go To button, press return, or double-click on the selected document.

¢ Documents Only: Check this option if you would only like to search document titles (this excludes
tag names, ref names, AC 800M function block names, etc. from the search)
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¢ Keep Open: Check this option to keep the dialog box open after going to a document rather than
having it automatically close.

2.4.4 Advanced: Finding a Coordinate

You can also enter a coordinate set to go to on a specific document - a helpful feature for finding messages
reported in the DBDOC.ERR files.

Spot the blinking red ball! Find the coordinates you are interested in on a given document easily without
having to scroll through it. Hyperview will go directly to the coordinates entered and zoom in.

: TENS TRILUNE m

1010212A.CAD
1010213a.cad
1010214A.CAD
1010215A.CAD
1010216A.CAD DS751165
1010217A.CAD ‘E FUEL CH4 SFLY FR
1010218A.CAD | & CTRL WLW CLOSED
1010219A.CAD £
1010220A.CAD

Coordinate Locator Dialog l ﬁ

VAP TB EXCIT.
AUTO SHMAMUAL

Enter the coordinate set to locate:

DADIO72 ‘

x: | 2000 y: | 2000

1560 350

Min x: Min y:

DAZS338A

CIRC WTR PMP A
MOV OFEM

3740

Max x:

[V Keep Open GoTo | Cancel

Max yv: 3740

DADIOT4 o

Three ways to bring up the coordinate locator:

e Select Find Coordinate under the Go menu option - enter the coordinate set that you want to go to
on the current document.

* OR Right-click on the drawing to bring up the popup menu and select Find Coordinate.

* OR use the keyboard shortcut Ctrl+G when the content pane is in focus.

When launched via the Go menu or the popup menu, the coordinate locator dialog displays the minimum and
maximum x and y values on the current drawing. The minimum values or the last entered coordinate set are

automatically filled into the edit boxes.

A message will appear when you enter a value that is out of range. Negative values are accepted where
applicable.
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Cancel the coordinate locator by double-clicking on it.

Coordinate Locator Dialog ﬁ

Enter the coordinate set to locate:

X: v | 1000
Min x: 1660 Miny: 260
Max x: 3340 Max yv: 3640

[+ Keep Open GoTo | Cancel

Check the Keep Open option to keep the dialog open after the Go To button has been clicked. This is useful
if you are iterating to pinpoint an exact coordinate set.
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2.5 Guide to Live Data on Documents

2.5.1 Live Data Monitoring

Hyperview provides read-only access to limited amounts of live data. Hyperview will display the data for
individual blocks as well as displaying analogue values in bar graphs where called for on graphics.

D Note: As of DBDOC 11.6, Hyperview can provide live text data for FC 151 text selector blocks.

There are three ways to fetch live data from your system:

* = | slow Mode (Camera) - preferred in general

o Continuous Mode (Clock)

* =2l Live Loop Annotations - live data for individual points

2.5.1.1 Using Slow Mode live data

To take a snapshot of the live data for all the outputs in the viewing area, click on the Slow Mode button IEI
on the toolbar. Hyperview will fetch the values of the outputs displayed. Click the camera button again to

fetch the live data values on the display again.

¢ Slow Mode will remain on until it is turned off by double-clicking the Slow Mode Button.

e When you view a different document, the values for it will be fetched automatically.

e |f you scroll or zoom on the current document, Hyperview will automatically refresh the values.

¢ If you do not scroll, zoom, or change documents, Hyperview will refresh the values every ten
seconds.

The shortcut keys used for Slow Mode are listed below:

e M - Turns on Slow Mode and will fetch all values on the CAD or CLD sheet you are viewing. Pressing
M successively will refetch the data on the sheet you are viewing.

e Shift+M - Turns off Slow Mode.

¢ F5 - Refetches the values on the CAD or CLD sheet you are viewing.

2.5.1.2 Getting live data in Continuous mode

You can activate Continuous mode live monitoring of your system by clicking on the Live Loop Display
button or selecting the option from under the View menu.
e Hyperview will send out requests at the desired frequency (by default, every second) for data for all

visible points in the drawing pane.
¢ The update interval can be changed in the Options dialog.

D Note: On dynamic bar graphs: The color of the bar displayed will indicate the status of the data. The
colors of the status bar are as follows:

34


http://wiki.gmcl.internal/w/File:Information-noshadow.png
http://wiki.gmcl.internal/w/File:Tool_camera.jpg
http://wiki.gmcl.internal/w/File:Tool_clock.jpg
http://wiki.gmcl.internal/w/File:Tool_create_lla.jpg
http://wiki.gmcl.internal/w/File:Tool_camera.jpg
http://wiki.gmcl.internal/w/File:Tool_clock.jpg
http://wiki.gmcl.internal/w/File:Information-noshadow.png

e Valid: bar will be green.
¢ Stale or unavailable: the bar will be drawn in red crosshatch.
¢ Bad quality: bar shown in the user specified bad quality color.

Note: If you attempt to monitor without having any live loop settings entered, Hyperview will automatically
alert you and give you the opportunity to enter settings at that point. This helps to take the guesswork out of
why you would not be seeing live datal

Dynamic graph display
when live loop
monitaring is turned on.

Live data points CONTEOLLING PRORES % DO

[Fc1l] [FC1]
3.@@% 2.00 20051 0.1469727
515945 8,9 3236 g AN e 5 7

7 00

L
L

2.5.1.3 Managing the Slow Mode Data Load

In Slow Mode, data is fetched automatically every ten seconds, and when you move the screen, zoom, or go
to another document, or explicitly refresh the values, providing an excellent balance between having the
most relevant up-to-date data, and not overloading the data bandwidth available. For most purposes, Slow
Mode will be the best option for minimizing data load due to on-document live data.

Slow Mode tips:

¢ Double-click the camera button to turn off Slow Mode. Slow Mode is never turned off automatically.

¢ On graphics, zoom in to the area you are interested in. Data is only fetched for visible points. If you
do not zoom in, it may take Hyperview several seconds to fetch data for the entire graphic.

¢ Switch to CAD / CLD sheets sooner rather than later. This will further reduce the amount of data
fetched.

If you use Slow Mode, you will leave a lot more bandwidth for other Hyperview users.

2.5.2 Live Loop Annotations

Live Loop Annotations are "sticky notes" displaying live data. You can add them to any document. You can
create a Live Loop Annotation to display live data for any block in your system, or module status for any
module. Live Loop Annotations are a convenient way to monitor block values, or module status for one part
of your system while looking at a different part of the system in Hyperview, or to display live data for just a
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few items on a document.

You can place Live Loop Annotations on any document that you can view in Hyperview’s content pane,
including graphics, text files, and database entries. If you want to monitor live data independently of what
document you happen to be viewing, consider using the Watch Window instead.

Live Loop Annotations are automatically saved, and will reappear on the documents where you created
them the next time you open Hyperview, even if you switch to a new build of your system. So if you always
need to refer to a certain block value while viewing a particular document in Hyperview, Live Loop
Annotations will let you do just that.

Standard live loop annotation:

(=1E=]
@ 1,20,02B 2158

237 AAHS5130
Custom Description Here

Live loop annotation with dynamic bar:

==
200

@ 1,01,02B 1036

171.25
Custom Description Here

Live loop annotation with data specs:

Ej Note: As of DBDOC 11.1 this type of annotation has been replaced by Live Specs.

Live loop annotation with module status:
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=G

%1,2@,@2 Status

Error Summary: Mo errors

Module Mode: execute

Module Type: NLIM@1,@2/NPIM@1

First time in Execute: No

LMM: memory OK

summary Remote I/70 Status: OK
summary Llocal 170 Status: OK

Calibration quality status for defined points: OK
Auto Initialization Input Status: reset
EEROM contains default configuration: Mo
summary Station Status: OK

Module Status: Good

PROCESSOR MODULE AD:02 @...

Use live loop annotations to:

¢ View live loop data for just one block in your system.
¢ Monitor live loop data from any Hyperview document.
¢ View the live module status for any module in your system.

For example, you can easily use Live Loop Annotations to keep track of the value of a tag, while viewing
that tag’s database entry.

GI5020 o
. 1,0503B 2513 |

I90demod [Tag Database] | ~
P8 GIS020

TAGNAME GI5020

TAGDESC BLOWER 1 1GV POSITION

LPME [ 55.2503]

TAGINDEX 3414

CUSTTAGID ELOWER No.1 IGV POSITION

TAGTYPE ANALOG

VALOD .0

SPAN 0.0

SETPTVALD 0

NUMDECPL 1

LOOP 1 2

To view help on Live Loop Annotations, right-click any Live Loop Annotation, then click Help.
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2.5.3 Creating a Live Loop Annotation

The Live Loop Annotation dialog is used to specify a value to monitor and to set or change the options for a
Live Loop Annotation.

Live Data Options For This Block

—Spedfy Value to Monitor: -
{* Value For Block Number

Loop: |1_ PCU: tl_ Module: | 2 Block: ‘ 5505

™ Value For Tag Name

TagName | Loop | PCU | Module | Block | Description

£

" Module Status

Basic Options -

Description: |

Update Interval: | 1 Seconds

Annotation Optio

Plot or Dynamic Bar Range

€ BultnRance | [

* Auto Range (caloulated on the fiy)

" Spedfy Range I':'

OK | Cancel

The Live Loop Annotation dialog is used to specify a value to monitor and to set or change the options for a
live loop annotation.

There are three ways to specify the point that you wish to monitor:

¢ By creating the live loop annotation on a hotspot
¢ By entering the block number
¢ By entering a tag name
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You can also monitor the status of a module.

To create a Live Loop Annotation on a hotspot:

® Click the Live Loop Annotation toolbar button then click the

hotspot. A Live Loop Annotation displaying the output value of the block will be created.

OR

Right-click on the hotspot, point to Create Live Loop Annotation for this Block, then click one of:
e Show Value
e Show Dynamic Bar

e Live Loop Annotation dialog

Choosing the Live Loop Annotation dialog will allow you to change settings such as the update interval and
the dynamic bar range. The other three options will create a Live Loop Annotation with the default settings.

You can create a live loop annotation on any hotspot with LPMB information, including on text documents
and batch files.

To create a live loop annotation that is not on a hotspot:

® Click the Live Loop Annotation toolbar button , then click the point on the content pane where
you would like to place the live loop annotation.

The live loop annotation dialog will appear so that you can specify which point to monitor.

To specify which point to monitor by loop, PCU, module and block humber:

Select Value For .. than anter the
Block MNumber loop, PCU
maduba, and block
‘ numbers hang
(¥ Value For Blodk Number I/
Loop: | 1 POU: |1 Modue:|2  Plock: | 5459

1. Click Value for Block Number.
2. Enter the appropriate information in the LPMB boxes.

To specify which point to monitor by tag name:
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Select Value For
Tag Name...

type in all or part of
the tag name you want
and click Search...

{* Value For Tag Name

Tag Name: | SOOm

...lhen select the
tag you wanl
from this list.

TagName | Loop | POU | Module | Block |
SOOMO0 1 1 1 2 M1
SDOMIEGW -1 2 2119 CHATE-
SDOMC 1004 2 455 CT-10

(o a Yl Lol
a

CEL™S

1. Click Value For Tag Name.

2. Enter part or all of a tag name in the Tag Name box and press the Search button. Hyperview will

look through the databases and present any matching tags in the list.

1. You can enter pseudo-tags to look for a particular point (e.g tagname@PV)
2. If you leave the Tag Name box blank, the search results will contain all tags in all databases

in the project.

3. In the search results list, click the tag name which you wish to monitor.

To monitor the status of a module:

[(_(¢ Module Status

Loop: | 1 PCU:

[T s

1. Click Module Status.

2. Enter the appropriate information in the LPM boxes.

2.5.3.1 Block Options (for either Live Loop Annotations or Watch Window Blocks)

Basic Options

Description: | GATE 5A
Update Interval: 0.1 Seconds

Annotation Oplions
* Show Live Data
¥ Dynamic Bar

Plot or Dynamic Bar Range

o l ]

* Auto Range (calculated on the fiy)
] 1

" Spedfy Range |I

Basc Options
Description: | GATE 5A M59
Update Interval: | 10 Seconds
Watch Window Options
l— D‘Iﬂﬂﬁ?
[T Reverse Y-axs
co: I e
Schedule
[PENDING] Autopause
after 24 hours Change
Plot or Dynamic Bar Range
" Built-in Range [ [
* Auto Range (calculated on the fiy)
(" SpecfyRange |0 [ 100
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2.5.3.1.1 Basic Options

2.5.3.1.

¢ Description: This text will be displayed when the mouse is hovering over a live loop annotation.

e Update Interval: The amount of time, in seconds, that the live loop annotation will display each
value before fetching a new value. The default interval for new annotations is one second. This
default can be changed in the View tab of the Options dialog (see p.58).

2 Annotation Options

e Show Live Data: If this is selected, the live loop annotation will show the current output value of the
block as a number.

e Dynamic Bar: If this is selected, the live loop annotation will show the current output value of the
block as a bar graph and as a number.

2.5.3.1.3 Watch Window Options

* Reverse Y-Axis: Reverse the vertical axis for the plot.

¢ Color: Change the plot line color for the selected block.

¢ Schedule: Set an automatic data collection timeout for the specified block. Blocks can be manually
paused and restarted, as before, but starting in version 10.4.1 automatic timeouts can also be set. A

block can be configured to automatically stop collecting data after a certain interval, for example 24
hours, or at a specified time.

2.5.3.1.4 Plot or Dynamic Bar Range

¢ Built-In Range: This option is only available if Dynamic Bar is selected and the block has minimum
and maximum values specified in one of the project databases. If this option is selected, the
minimum and maximum values from the database will be used for the limits of the bar graph.

e Auto Range: This option is only available if Dynamic Bar is selected. If this option is selected, the
bar graph limits will adapt to the data fetched.

¢ Specify Range: This option is only available if Dynamic Bar is selected.. If this option is selected,
the bar graph will have the limits you specify here.

2.5.3.2 Reading Live Loop Annotations

You may see the following symbols and abbreviations on live loop annotations:

V]

Successful data fetch

Error
* Bad quality
g::‘g Alarm

Info - the version of CIUMon that you are currently using to monitor with has been configured for a
certain loop and PCU and the point that you are requesting data for does not match that
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configuration.

The IP address of the computer you are currently monitoring from has not been approved by
CIUMon to fetch live data. You will also see IP_BLOCKED displayed in the manual live loop data

window.
H High
L Low

D Deviation

C Calibration

S Service

If the symbols on an LLA are greyish, this indicates that the data is stale.
2.5.3.3 Managing Live Loop Annotations

You can view a complete listing of all live loop annotations by:

® Clicking the Manage Annotations button on the toolbar
* OR Selecting Manage Annotation from under the View menu and clicking the Live Loop

Annotations tab.
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Live Loop Annotations [LLA)

B User Live Loop Annotations
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197.23.03 B 1233 {1 5 updates)
& System Live Loop Arnotations

Dl
Salacted
Annolations

Search
FAnnotations

1

Arnclsbions
From Fle

Specify Value to Monkor,
= Vaue For Black Number

Loop:[197  PCL[B Modue: i Bock:[1233
™ Value For Tag Name

[ | seach |

[ 1eep | pou | Mosule]| Biock | Deerpsor

Tag Hame

For a selected annotation, you can:

¢ Change what value it is monitoring.

¢ Change any of the options, including Mouse-over text, Update Interval, and Dynamic Bar settings.

2.5.3.4 Moving Live Loop Annotations

To temporarily move a live loop annotation, click and drag it to a new position. It will be linked to its
permanent position by a thin line, or "rubberband". If the annotation was created on a hotspot, the
rubberband is useful as a pointer to that hotspot.

To move an annotation back to its permanent position, double-click it.

To minimize a live loop annotation, click the Minimize button =]l on its upper right hand corner.

To permanently move a live loop annotation, minimize it, then click and drag the minimized annotation to a

new position.
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2.5.3.5 Deleting Live Loop Annotations
To delete a live loop annotation from the content pane:

¢ Click the Delete button [l on the live loop annotation's upper right hand corner.
* OR Right-click the live loop annotation, then click Delete Live Loop Annotation.

To delete live loop annotations using the annotation manager:

¢ To delete a single live loop annotation, select it in the list of annotations, then click Delete.

e To delete all live loop annotations on a topic, select the topic in the list of annotations, then click
Delete.

e To delete all live loop annotations in the entire project, select the top entry in the list of annotations,
then click Delete.

2.5.4 Live Specs

Live specs can be turned on in the View menu by selecting Enable Live Specs. On layered specs, live spec
values will then be displayed directly. Prior to DBDOC 11.1, these live specs would have to be displayed as
their own type of live loop annotation.

Just as with refreshing live data values in Slow Mode, clicking the camera in the bottom right of the specs will
refresh the values. Unlike in Slow Mode, these specs do not update automatically over time.

Live specs appear in two places: in the layered spec rectangle, and on the inputs.

1. General specs
¢ Appear in a large movable rectangle.
+ Black text means the spec's live value is same as its static value.
+ Green text means the spec's live value is different from its static value (probably not an error,
though).
2. Input specs
¢ Appear as small rectangles around each of a block's inputs.
¢ A green rectangle means the spec's live value (i.e. the block number of the input) is the
same as its static value.
¢ A red rectangle means the spec's live value (i.e. the block number of the input) is different
from that implied by the wiring. This could well be unexpected, and so it is highlighted.
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2.6 Trending Live Data in the Watch Window

2.6.1 Watch Window Overview

The Watch Window allows you to plot live data from one or more points in the same window. It helps
troubleshoot problems and analyze the way the system works. Add blocks from anywhere in the system to a
window that displays their values in an easy to use plot. Control the range, resolution and data collection rate
of each block.
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2.6.1.1 Using the Watch Window: quick summary

e Adding a block to the Watch Window can be done effortlessly by right-clicking on a block and
selecting Add this Block to the Watch Window.

* Once a block has been added to the Watch Window, it will begin collecting data. As you move the
mouse over the plot, crosshairs appear showing you exact data values.

¢ Click on the plot to place a Timestamp showing the value and time of a point of interest.

¢ Blocks are added in Split Plot mode with AutoScaling enabled. This gives you a natural starting
point. One click and you display them in one plot. One click and you rescale the plot of the value.

¢ You can easily walk through Timestamps by using the Back and Forward Navigation buttons at the
bottom of the Watch Window.

¢ Using the Block List, you can hide the plot for a block by unchecking the checkbox on the left-hand
side. Autoscaling and pausing data collection for a block can also be enabled using the Block List.

¢ Using our simple Export Data tool, you can export the data for the group for a selected group into a
.csv file for import into Microsoft Excel® or other external applications.
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2.6.2 Opening the Watch Window

You can open the watch window from the Hyperview window in three ways:

® Click the Live Data Watch Window button == in the toolbar.
* Press W on your keyboard.

¢ Click View | Watch Window in the main menu.
2.6.3 Adding blocks to the Watch Window so they can be plotted
There are several ways to add a block to a group in the watch window:

1. On any CAD, CLD, graphic, AutoCAD or Microstation drawing, right click on any source or output
hotspot and select Add this Block to the Watch Window. The point will be added with the default
options to the watch window group you choose.

2. Right click on any live loop annotation and select Add to Watch Window. The point will be added to

the watch window group you choose using any live loop annotations options you already entered.

. In the Live Data Watch Window, click the Add Block button and define the block you wish to add.

. In the Live Data Watch Window menu, choose Block > Add and define the block you wish to add.

. Right-click on any block in the block list and choose the Add Block menu option.

. Right-click on a blank area of the block list and choose Add Block from the menu.

oo O W

2.6.4 Defining and editing block plots in the Watch Window

If you are specifying a block to add to the Watch Window by block number or tagname, or editing options for
an existing block in the Watch Window, you will use the Block Live Data Options dialog.
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Live Data Options For This Block >

—Spedfy Value to Monitor: -
{* Value For Block Number

Loop: |1_ PCU: il_ Module: | 2 Block: ‘ 30355

™ Value For Tag Name

Tag Mame lLoop [ PEU[ Mndiﬁe[ Block [ Descriptiol

£ >
" Module Status

Basic Options -
Description: |GATE SA MS9

Update Interval: |1[! Seconds
Annotation Optic 1 —Watch Window Options
™ Reverse Y-axis

Color: - Change

Schedule
[PENDING] Autopause

after 24 hours Change
Plot or Dynamic Bar Range
" Builtin Range I [
* Auto Range (caloulated on the fiy)

(" SpecfyRange |0 o [ 100

OK | Cancel

To edit the options of an existing block with a plot in the Watch Window:

¢ Double-click the block in the Block List on the right hand side of the Watch Window..
¢ Right-click the block in the Block List and choose Edit.

e Select the block in the Block List and click the Edit Block button.

e Select the block in the Block List and choose Block | Edit from the menu.

The Edit dialog that appears is the same as that which is discussed in the section of the User Guide on Live

Loop Annotations.
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2.6.4.1 Specific Watch Window Options
The following block options are specific to Watch Window blocks.

* Reverse Y-Axis: Reverse the vertical axis for the plot.

¢ Color: Change the plot line color for the selected block.

¢ Schedule: Set an automatic data collection timeout for the specified block. Blocks can be manually
paused and restarted, as before, but starting in version 10.4.1 automatic timeouts can also be set. A
block can be configured to automatically stop collecting data after a certain interval, for example 24
hours, or at a specified time. If you like, by checking Confirm before pausing you can require that
Watch Window obtain confirmation before automatically pausing data collection for any block.

s '
Watch Window Autopause Schedule l&]

Specify a tmeout schedule for Module 1,01,02 Blodk 2086,

(" Mo Scheduled Pause

-
* Autopause

C after [24 [hours  ~]|

“at |29 = |70~

[~ Confirm before pausing

2.6.5 Creating groups of blocks in the Watch Window

Create different groups of points to keep your watch window uncluttered. Make sure to specify a unique
name for each group that you create. Create a new group by clicking on the Add Group button or choosing
Add from the Group menu in the Watch Window. This will give you an empty group to which you can start
adding the blocks that you want to monitor.

2.6.5.1 Importing a list of blocks from CIULink

If you are monitoring blocks using ClULink, you may want to transfer them to the Watch Window.

Import a taglist created in CIULink as a group. Choose the Import option from the Group menu or click the
Import Group button.

You have the choice of browsing for an exported .LST file created by CIULink or choosing from the list of
CIULink taglists that are currently stored in the registry.

The group will be populated with all the points in the chosen taglist - saving you from having to enter each
point individually.
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2.6.5.2 Managing groups of blocks
Manage your groups:

e Through the Group menu in the watch window.
e With the various Group buttons available on the Watch Window toolbar.
e By right-clicking the on the group tab name and selecting the appropriate action from the menu.

2.6.6 Watch Window Highlights

¢ Crosshairs: As you mouse over on the plots, you will see red crosshairs appear for each block that
you are monitoring. The LPMB information and the data value will appear next to the crosshair
making for easy interpretation of the plotted value. To leave a timestamp so are able to return to a
point of interest just click the mouse. These stamps will persist as the Watch Window collects new
data. They can be deleted by clicking the X in the top right-hand corner. In addition, you are able to
move through the crosshairs by using the navigation button at the bottom of the Watch Window.

¢ Navigation Plot: A second timestrip-type plot below the main plot displays all the data that has been
collected for the group. The beginnings and ends of data runs are indicated with green and red flags,
and you can jump from flag to flag by using the Data Run Marker Navigation buttons below the
navigation plot.

¢ Freeze Scroll: By clicking on the Freeze Scroll button located at the bottom left of the watch window
or dragging the horizontal scroll bar, the plot will freeze, allowing you to look at the any portion of the
data without having it continuing to scroll to the left. The background of the plot will change from
white to a light gray to indicate that the scrolling is frozen. To unfreeze the scroll, click the Freeze
Scroll button and the plot will jump to the current time.

¢ Plot Time Scale: You can adjust the time scale against which the plot is drawn; by default, the value
is 1.00 sec/pixel. You can expand the plot by entering in a smaller value or compress it by entering a
larger number in the Plot Time-Scale field. Enter the desired value in the field and click the Apply
button or just press Enter.

e Split Plot: Spilit plot allows each block to be placed onto its own separate plot to be graphed
separately. If you look on the left-hand side the range of values being graphed is shown at the top
and bottom of the plots. This gives you a better view for analyzing your data.

¢ Always keep the Watch Window visible: Under the Options menu in the watch window, check the
Always display Watch Window on Top option so that the window will float on top of all other

windows and will always be visible to you.

¢ Exporting Data: You are able to select which data you wish to export from the Watch Window. By
pressing the Select Mode button on the toolbar, it will allow you to drag the mouse pointer to select
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the data you wish to extract for further analysis. Once you have made your selection, press the
Export Data button, which will confirm your selection and export the data to a CSV file. The data in
the CSV file displays very nicely in Microsoft Excel.

¢ Go To Source or Go To Block Map: These options are available by right clicking on a block in the
block list. Go To Source will take you to the CAD or CLD sheet where the block is used. Go To
Block Map will take you to that block’s entry on the Block Map.

2.6.7 Timestamp Navigation

Timestamp Navigation buttons make the task of navigating through timestamps much easier.

Jump to the left-most timestamp on the plot.

Jump to the previous (next left) timestamp on your plot.
Jump to the currently selected timestamp.

Jump to the next (next right) timestamp on your plot.

* Jump to the right-most timestamp on your plot.

2.6.8 Data Marker Navigation

A navigation plot below the main plot makes it easy to move through different datasets collected at different
times.

EEEE W gl - | |
LU 17.09:00 475 LU

HADLIC209 1,200 B 2550 E103

300 HADLICIOIERSP 1.20,02 8 2551 Setpoint for ADLIEIONS m 2 B 288

Dragging this frame on the navigation
plot changes the plot display above.
The main plot always shows whatever is

H inside the frame.

All Data . : ;

0:00 02 00 0 2 13 e
Shown
q V
Timestamg ' Data Run Marker Plaot 1 Seconds 3
Havigation ﬂjil'ﬂﬂm Havigaticn !Iﬂﬂﬂ Resalution o Fer Fixel MN"’

With the Data Run Marker Navigation buttons you can step through data collected at different times.
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¢ |81 Jump to the left-most data run marker.
Jump to the previous (next left) data run marker.
Jump to the next (next right) data run marker.

¢ [l Jump to the right-most data run marker.

2.6.9 Managing Watch Window related bandwidth, and disk usage

These topics are covered briefly here, and in more detail in the User Guide chapter Guide to Managing Live
Data Load and Increasing Live Data Bandwidth.

Staius of connection to the
CIUMon live data server.

Combined size of all the Watch
Window data files for this project.

ClUMon List 1 [Send/s:1.00 Recv/s1. 19| Data Files [52KB)

Mumber of data responses per
second Hyperview is receiving.

Number of data requests per
second Hyperview is sending

B

This Live Data Status Bar provides useful information regarding how many data update requests are being
made per second, how many updates are received, how much memory is being used for the Watch Window
plots, and how much disk space is being used for Watch Window data files.

2.6.9.1 Bandwidth

In general, a CIU is able to provide responses to no more than 30 requests per second. If multiple users are
sharing one ClIUMon to CIU connection, they will be limited collectively by that data bandwidth.

With a bit of care, you will be able to use the full power of the Watch Window without overwhelming the
limited bandwidth available. Here are some tips to keep the Watch Window data fetch rate from being any
higher than necessary:

Tips for managing Watch Window data bandwidth:

¢ Look at Send/s and Recv/s in the Live Data Status Bar at the bottom of the main Hyperview
browser to see what data requests Hyperview is sending and receiving.

¢ If Send/s is larger than Recv/s, data updates are not "keeping up" with requests. Consider reducing
the data load.

¢ Be aware of the data update requests being generated by the main browser window. Consider

turning off live data in the main browser or switching to Slow mode .
¢ Be aware that the Watch Window collects data even when it is not open.
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¢ When you add a block to the Watch Window, it will fetch new data once every 10 seconds. If you
don’t need to collect data that frequently, increase the update interval.

e If you don'’t need the data from a block, but wish to keep it defined in the Watch Window, pause data
collection for that block.

2.6.9.2 Memory

Prior to DBDOC 10.4, Watch Window plot data was stored in memory. If a very large amount of data had
been collected, this could affect performance.

As of DBDOC 10.4, trend data is loaded for display on an as-needed basis. Large datasets will not cause the
general memory requirements of Hyperview to increase.

2.6.9.3 Disk Usage

All data collected in the Watch Window is automatically saved to CSV files. Over time, these files can
become large.

Tips for managing Watch Window memory use:

¢ Look at Data Files in the Live Data Status Bar at the bottom of the main Hyperview browser to see
how much disk space is being used for Watch Window data files (including those not currently in the
Watch Window).

e Deleting data from inside a plot (i.e. by selecting it and deleting it) in the Watch Window will remove it
from memory and also from the data files.

e |f necessary, you can delete the data files directly. See Guide to Managing Live Data Load and
Increasing Live Data Bandwidth for details on their location.

2.6.10 Importing data into other applications

The best way to use Watch Window data in other applications is to export it. It should rarely if ever be useful
to use the raw data file directly.

How to export data:

¢ Select the data in the Watch Window you wish to export. Data for all the visble plots in the visible
group will be exported. Hiding a plot will prevent it from being exported.

¢ Press the Export Data toolbar button. You will be able to choose the interval size for the exported
data and the file to which the data should be saved.

¢ You will have the option of viewing the data immediately in the application associated with CSV files
on your system, typically Microsoft Excel.
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2.7 Viewing and Managing System Errors with the Error Browser

2.7.1 Error Browser Overview

The Error Browser is a powerful tool that allows you to easily examine the errors in your system configuration
that DBDOC detected while compiling your project. Because DBDOC integrates information across many
sources throughout the system, it is in a position to detect inconsistencies and possible problems, ranging
from serious errors to cosmetic issues. For many years, these errors have been available for viewing in
compiler generated text files, but as of DBDOC 10.5 they are presented in Hyperview in a dedicated error
browser. This enables you to click on errors to jump directly to the associated location in the project file,
review errors methodically, and hide errors that you don't need to see. Errors can be filtered, sorted, and

grouped in a variety of ways to help you get a handle on them.
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2.7.2 Opening the Error Browser

You can open the Error Browser from the Hyperview window in three ways:

® Click the Error Browser button II‘ in the toolbar.
* Press E on your keyboard.

e Click View | Error Browser in the main menu.

The Error Browser will be displayed showing the errors that were detected the last time the project file was
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built. Click on the + next to any of the branches to expand it and show the individual errors inside. Clicking on
an individual error will cause the full error message along with brief documentation to appear in the panel
below the error tree. Most errors contain hyperlinks (in blue). Click on these to display the associated
locations in the main browser.

2.7.3 Marking errors as Starred, Reviewed or Hidden

In order to help manage errors in the Error Browser, you can mark them in one of three ways:

Star — use to indicate that an error requires attention.

= | Review — use to indicate that an error has been looked at and evaluated.

“ ¥ Hide — use to indicate that an error does not need to be further examined and can be hidden
from view.

Using the Show these errors option on the left, you can filter what errors are shown in the tree based on
how you marked them. For example, you can show only errors that are "not reviewed." The error marks are
persistent, and will reappear when you next run Hyperview, and also when you view a new version of the
project file in Hyperview.

2.7.3.1 Marking individual errors

You can toggle whether an individual error is marked as "starred," "reviewed," or "hidden" by clicking on the
small icons to the left of every error item in the tree.

B-Loop 1 PLU 4 (13 shown)
& '] Imported block has no source - module not built [265]: Medule 1,04,02 Block 3956
© ¢ 2] imported block has no seurce - module not buitt [265]: Medule 1,04,02 Block 3957
L L 12 Module 1,04,02 k 395
& 4] Imported block has no source - module not built [265]: Module 1,04,02 Block 5791
& 5] Imported block has no source - module not built [265]: Medule 1,04 02 Block 5752

2.7.3.2 Marking selected errors

You can also select an error, and use the toolbar icons to mark it.

+-Loop 1 PCU 3 (21 shown)

=]
L&) Imported block has no source - module not built [265]: Module 1,04,02 Block 3956
@ (2] Imported block has no source - module not built [265]: Medule 1,04,02 Block 3957
Oy il §,02 Bloc 5
& [4] Imported block has no source - module not built [265]: Medule 1,04,02 Block 5791

If you click on a "branch" item in the error tree, all of the errors in that branch will be selected. You can then
use the toolbar to mark all of those errors at once. Shift+Click can be used to select a range of errors, and
Ctrl+Click can be used to select multiple non-adjacent errors.
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o o

i Mark the selected error(s) as "Reviewed”
[2RConfiguration |25 snuwnj

distinct emrors in tree; 34 don’

=R Probable system configuration error: Evaluate - high prionity (230 5
w200 Possible system configuration error: Evaluate - medium priority (8]

smetic system confiquration issue: Evaluate - low prionty (4

B ultiple wires at source: assuming connector [219]; 2500, 2501
= [I[F8] System information message: For information purposes (28 shown)
= [T DEDOC program problem: Report to GMCL (3 shown)

2.7.4 Filtering errors

All the errors that were detected during the last DBDOC build are built into the project file and can be
displayed in the error browser. Because large number of errors are common in systems that have not yet
been "cleaned up," it is important to be able to filter them in various ways.

The Show these errors drop-down menu to the left of the error tree allows you to display only errors that
have been marked in certain ways. For example, choosing "Hidden" (and then pressing Rebuild) will cause
only the errors that have been marked as "hidden" to be shown in the error tree. "Active" will show the
non-hidden errors. Similarly, starred, reviewed, and not reviewed errors can be specifically displayed. You
can always see every error by selecting "All" as this option.

As you become familiar with the errors in your build, you will invariably discover categories of potential errors
that are not "real" errors in your system because some context explains their existence and they are known
to not be harmful. Errors with "CHECK" severity will tend to fall into this category. Since those errors are not
"real," they may never be corrected at the source (in your actual configuration) but you can nevertheless still
mark them as "hidden" so that they do not clutter up the Error Browser error display.

2.7.5 Grouping errors

The error tree can be organized in a wide variety of ways based on the attributes of the individual errors.
Most errors are associated with particular locations in the project, and can be grouped by file. Errors can be
associated with particular subsystems, such as graphics, configuration, or database, and can be grouped
accordingly. Many errors refer to particular blocks, and can be organized by Loop, PCU, and Module. Errors
can be classified according to their severity. Some errors are serious and should be corrected. Others are
cosmetic, and could be tidied up, but can also just be hidden if you don't want to deal with them. If you have
worked with DBDOC's previous text file error support (.ERR files) you may find it convenient to group errors
according to what error file they appear in.

Because entire branches of the tree can be selected with a single click, and then marked with another, the
ability to group errors provides a powerful way to understand and manage your errors.
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2.7.6 New errors

Every time your project file is rebuilt, the errors generated during the build are built into the project file for
viewing in the error browser. When you open the error browser, information about the errors is stored in a
local database by Hyperview. This allows Hyperview to detect "new" errors (i.e. errors that have newly
appeared in the new version of the project file you are looking at). These "new" errors are highlighted in the
error browser to draw them to your attention.

m-TSTQ tests block with ne quality [063] (3 shown)
@-X coordinates out of order [033] (3 shown)
= Build setup emor: Contact GMCL build support {1 shown)
@-Font file not found [191] (1 shown)
= |: Possible system configuration ermor: Evaluate - medium prionty (38 new of 677 shown)
m-Adapt block adapts previous block [118] (30 shown)
@ Display not found [197] (47 new of 47 shown)
m-Fix) discontinuity (step) [031] (2 shown)
@-Live wire not connected [193] (2 shown)

2.7.7 Sharing error information with other users

If you register for data sharing, other Hyperview users will be able to see which errors you have checked or
starred, and you will be able to see which errors they have marked.

This is a powerful capability that makes it easy for a group to collaboratively assess and review errors. You
could, for example, filter to show only the errors that had been reviewed by another user, select them with a
single click, and then hide them all in your Error Browser. Or you could selectively display only the errors
starred by another user, select them, and then mark them as "reviewed."

You can register to share data using the Sharing tab of the Properties dialog, accessible from the Options
menu in the main Hyperview browser. Once you are registered, your error information will be automatically
shared, and you will see the information of other sharing users.

Once you have registered for sharing, other registered users using the same data sharing folder will show up
in this checkbox list. Check the checkbox for a user to make their data show up in the tree. In the example
below, stars and checks from Jane and John will be displayed to the right of the errors in the tree.

Include stars/checks from El-Fix) uses large valugs and may not clamp output [034] (24 shown
| Module 1,01,02 Block 1336
Module 1,01,02 Block 1641
] Module 1,01,02 Block 65665
4] Medule 1,01,02 Block 2337 %O
Wedule 1,01,02 Block 600 ©
Medule 1,01,02 Bleck 601 @
Module 1,20,02 Block 1028% @

Q

[ you: desiyn on CTHULHU
[v] John Smith (IEUser on IE10W
[w]Jane Jones (IEUser on IE11W

Q00QCQQ

By selecting various combinations of Show these errors and Include stars/checks from options, you can
easily display very specific categories of errors.

For example, this combination shows only the errors starred by John:
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[ 1ars Jonas 1EUsa an IE11'-'.|:

=1-SAarned armors win Severty and Error Name amnbutes (3 shewn, 1145 donl have theds afiriteies)
=l [ERROR] Probabie sysiem configuration ermor: Evaluate - high priorty (3 shown)
= Fix} uses arge values and may not clamp catput [034) (3 shown)
PG 1] Modais 1.01,02 Block 13369
O [2] Module 1.01,02 Block 2337 W
O [2) Modiale 1,20,02 Block 1029% @

Hyperview automatically detects changes made to errors by other users. When such a change is detected,

the Rebuild button

Rebuild Tree
Shared Data Updates Found

in the Error Browser activates. The detected changes will be

included when the tree is rebuilt.
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2.8 Customizing the Browser Display

2.8.1 Showing and hiding specs and attributes
2.8.1.1 Viewing specs on CAD/CLD diagrams

On a CAD/CLD sheet, block specifications can be hidden, or viewed in two different ways - either drawn
directly on the sheet or drawn on a gray background.

To view specs:
® Press S on the keyboard
* OR Select Specs on the View menu and choose the view you want.

* OR Right-click on a CAD/CLD Sheet, select Specs in the View option of the popup menu and
choose the view you want.

I Note: The key C formerly was used for this purpose, until DBDOC 10.2.

Cycle through the different displays and turn off the specs by pressing S on the keyboard.

DIRECT
| Slgl. A |[FC19]
L Slgl., PID 57
453... N s
Y

S5  0.083333

S6  1.43

S7  13.28

S8 0.5

S9  100.0

510 -0.5

S11 0

51
512 1 5
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What if the specs are obscuring other information on your CAD/CLD sheet?
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¢ In the opaque mode (layered specs), click and drag the specs windows to different locations.
Some interesting features of the Specifications window:

¢ A "rubberband" links the spec window to its original position so that it is always clear which set of
specs belongs to which block.

¢ Double-click on the spec window and it moves back to the original position at which it appeared.

e The locations of your specs are retained between Hyperview runs so once you have moved your
spec windows to the locations that you like, they will stay there until you move them again.

e Live values for specs modified by Adapt Blocks is shown right next to the block they belong to.

2.8.1.2 Viewing attributes on CAD/CLD diagrams
On a CAD/CLD sheet, DBDOC displays the tag name and tag description above a tagged,
exception-reported block. Like the specs, the attributes can be hidden, drawn directly on the sheet or drawn
on a gray background. To view attributes:

* Press A on the keyboard

* OR Select Attributes on the View menu

* OR Right-click to bring up the popup menu and select Attributes from the View menu option.

Cycle through the different displays and turn off the attributes by pressing A on the keyboard.
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2.8.1.3 Showing live specs on CAD/CLD diagrams

New in DBDOC 11.1, live specs can now be displayed on top of static specs. These can be enabled by
selecting Enable Live Specs in the View menu.
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Live specs can then be turned on and off individually for each block by double clicking the camera in the
bottom right corner.

2.8.2 Highlighting options in Hyperview
2.8.2.1 Highlighting search hits
Search Hits: With this option checked, search hits are highlighted on the document and you can scroll to the

next or previous search hit. This may also be turned on via the popup menu that is brought up by a
right-click. Select Search Hits from the Highlight sub-menu.
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2.8.2.2 Highlighting hotspots

Hotspots: Highlights all the hyperlinks on a page. This is useful for determining the location of hyperlinks in
a textual or graphical display. You can also use the Ctrl+Tab key combination to show all the hotspots on a

page.
2.8.2.3 Showing "Vegas Lights"

Vegas Lights: With this option checked, a colorful marquee will appear to highlight your target. You can
press V on your keyboard to toggle Vegas Lights on and off.

2.8.3 Options Menu: Properties for Hyperview

2.8.3.1 View options

Properties for Hyperview x
View ]UveLnupS&tupl Eﬂluts] F'rint5&lli'|gs] Sharingl
- General Settings -
W Wrap toolbar r Default Date Format| — On Stadup

[ Full document path in title bar | = MM-DD-YYYY " Opento Home page

I™ Legacy scroll & zoom mode " DDMMYYYY | | 5 Opentolast viewed
(Press CTHLto access page
non-selected mode) '

Magnify text documentsby: |100 =% [ Enable GDI+ drawing o fix missing lines)

— Hatspeot Enabling
[ Enable function block hotspots [ Enable function code hotspots

8 Lilfe_[iata Appearance — T Lwe .Da!a .Cu.:.\mmuricati_uns -
Live data font: |Ehd-:|czyg¢n Sans ﬂ k'npmir‘g:;.ral: |'1_DD_
Live Loop Annotation text size: I'lsi ?;ﬂz;?ma’: Iﬂi
Live Loop Data teut size: lw— ¥ Enable legacy networking code
[ Enable networking log

* | By default, live data is disabled for
 Teat Annotations 1| blocks with no sounce, unless they
are marked as Bxdemal in the build.

Tert size: |16 [~ Enable live data for Live Loop

I R et ooy e Annotations and Watch Window
Airirnize A1 Systern Anmotations ks wahing

[ Minimize A1 System Live Loop Annotations

Folders to Search for Extemal Files

These folders are searched in order if the folder path in the project file is incomect.
Separate paths with the vertical bar character "T".

[ Restore all dialogs suppressed with "Dont show this again™

0K | Cancel
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An overview of the features available on the View tab of the Options window:

¢ General Settings:
+ Wrap toolbar: Controls whether the toolbar will wrap around instead of getting cut off if the
Hyperview window is too small.
+ Full document path in title bar: If set, the title bar will display the entire path to the open
project file.
¢ Legacy scroll & zoom mode: Controls scrolling and zooming are inputted on
graphics/CADs/etc. See the Guide to Basic Navigation in Hyperview for more information.
+ Default Date Format: Specify the date format you prefer to be used throughout Hyperview.
+ On Startup: If set to "Open to last viewed page," Hyperview saves the last document viewed
before it closes so that when it is reopened, the project will be opened to that document. If
set to "Open to Home page," the project will open to pages specified by the Home button.
+ Magnify text on text documents: Magnifies the all text documents in Hyperview by the set
amount.

+ Enable GDI+ drawing: Under certain circumstances, CAD/CLD drawings can have "missing
lines". This tends to happen on certain platforms when displayed on a remote desktop.
Usually switching to the GDI+ graphics library solves this problem if you encounter it.

¢ Hotspot Enabling: Specify whether you wish to enable Function Code and Function Block hotspots.
These are not critical to regular signal tracing, and can be disabled for convenience.

e Live Data Appearance: Select the font and font size used to display live data.
e Text Annotations: Select the size of the font for the text that appears in your text annotations.

e Live Data Communications:

+ Update interval: Set how often on-document live data is fetched in continuous mode.

+ Stale data interval: Set how long data is displayed as fresh before being displayed as stale.

+ Enable legacy networking code: This causes Hyperview to use an older method for
connecting to CIUMon, required on some older platforms. It should not be harmful on newer
platforms.

+ Enable networking log: Debugging feature.

+ Enabile live data for Live Loop Annotations and Watch Window blocks with no source:
Attempt to fetch on-document data even for blocks that neither have a source in the
configuration built into the project file, nor have been marked available in BuildPlus. Turning
this on may cause problems, since data for such blocks may not actually be available.

¢ Folders to Search for External Files Specify additional folders to be searched for external files
(files not built into the project file). See Viewing external files for more information.

* Reset to show all suppressed dialogs: Check this option to have the No Search Results and
Bookmark Message dialogs appear the next time they are triggered.
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2.8.3.2 Color options

Properties for Hyperview >

View | Live Loop Setup Colors | Print Settings I Sharing I

Change I Restors default.l

Change | Restore default |
|

—General
Text:

Search hits highlights:

il

Active pane border: Change Restore default .l
— Live data

Backaround: I— Change | Restore default |
Digital data "1": - Change | Restore default .l
Digital data "0": Ii Change | Restore defautt |
Bad quality data: - Change | Restore default .l

— Annotations
Text annotations: I Change | Restore default |
Live loop annotations: I Change | Restore default |
System text annotations: I Change | Restore default |
System live loop annotations: I Change | Restore default |

Restore all default colors |

oK Cancel | pply |

These options allow you to change the colors of various features within Hyperview. For example, you can
change the colors for annotations.

Text Annotations:
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Restore default annotation colors with the Reset colors to default button.
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2.9 Making Notes on Documents

2.9.1 Overview of Annotations

Annotations are like electronic sticky notes that you can attach to the majority of the documents contained
within your project. There are two types of annotations that you can create:

1. Text-based Annotations: Make comments on a document to keep track of important things to note.
2. Live Loop Annotations: Create a note on a document that can fetch the live data value of any
particular point in your system from anywhere in your project .

2.9.2 Text Annotations
Annotations are notes that can be created by two methods:

¢ Right-click on the document and select Create Annotations from the Annotations option on the
popup menu.

® Click the Create an Annotation button IZI on the toolbar, and place the annotation on the desired
document.

BE
This valve is taking 15 mins to
close, which is too long!

B[E
30PIC25010Q
(C NTX ) ’ 15 mins is too long!

[FC45
— Sl pOJL —
2495

52 1

Text annotations will persist across builds of your system. If you remove a topic, it will be listed as an Invalid
Topic in the Manage Annotations dialog box. If you add a file back into your build it will activate the
annotations that were originally on that document.

2.9.3 Managing Annotations

To move an annotation, drag and drop the annotation window or anchor point to the location you want.

If you have to make the same note in different places, you can make a copy of the original annotation and
paste it anywhere you want. On the original annotation, right click and select Copy Annotation from the
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popup menu. Navigate to where you want to paste the annotation, right-click, and choose Paste Annotation
from the Annotations menu.

[Fiz4] L_JITE?
=8 | E |
| T"‘ 4
T o | -
Text Annatation ] Create | —l_
Live Loop Annotation ] Paste h | |
Specs i Minimize Al |
1 Attnibutes / Tag Names ] ectars Al |
Live Fix) Graphs ] I |
II__|.. [FE13]
Highlight P Sl ToINT | |
53 L8411 J
Audit Windew... - > |
Set Toom Factor 4
Find Cogrdinate...
=] Rotate Counterclockwize
Rotate Clockwise Shift«R
Go To Bleck Map N
Bookmark This Tepic...
Mark This Topic For Printing
Make This Topic My Content Pane Home Page |
Document ] |

You can minimize or open all text annotations on a document by selecting the Minimize All Annotations or
Restore All options respectively in the Text Annotation option on the popup menu.

¢ Minimized annotations will appear on the document represented by an anchor point.

¢ To open an individual annnotation, click on the anchor point.

¢ Click the minimize button I=ll in the upper right-hand corner to minimize an annotation.
You can view a complete listing of annotations by:

® Clicking the Manage Annotations button on the toolbar

* OR selecting Manage Annotations under the View menu

This will bring up the Manage Annotations dialog box: Click on the Annotations tab.
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Clicking on either the topic or an annotation in the list will automatically take you to that document.
You can edit text in the annotation by either:

¢ Changing the text in the original annotation window (double click on the window to open the editor or
right click on it and select Edit Annotation from the popup menu)

e Edit the text in the right hand pane of the Annotations page in the Manage Annotations dialog. The
changes will be reflected in the actual annotation window when the user makes a different selection
in the document tree or the Manage Annotations dialog is closed by clicking the OK button.

¢ You can also delete individual annotations by right clicking on an open annotation and choosing

Delete Annotation in the popup menu that appears or by clicking the [zl in the upper right-hand
corner.

How to restore a deleted annotation:

1. Close the project file.
2. Editthe [project name].ann file.
3. Remove Delete... line

4. Modify Visible from 0 (zero) to 1. You do not have to change the associated hexadecimal value
0x00000000.
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You can look for specific text in your annotations by clicking on the Search Text button in the Manage
Annotations dialog.

Type the text you
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------------- choose the type
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¥ User Arwstutiora ¥ Sranem Arvetstord - | are loaking for...

I ey Live Lisp Annciators: ™ Syaners Live Lons Avetatend

| Top riame | Armataton
b5 - EVLLILL,, Ths 5.3 sample bext srrotston
Mode |

Samply Bock
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| " [T ———— ..and select an annatation
Mot 197,200, Ths & 5 saemgie beul arraiation “-_‘_-_'_'_‘—ﬁ-_._ here to diﬁﬂ'ﬂ}' it in the
Annotation Manager,

Type the text you are looking for in the Find What edit box, choose what you want to search in, and then
click the Search button. Any annotations found to match your criteria will be shown in the list. Click on any
item in that list to go directly to the document.

You have the ability to print your documents either with the annotations visible or suppressed. When they are
suppressed, you won't even see the anchor point on the printout.

To suppress annotations while printing, uncheck the Print Annotations checkbox in the Print dialog or on
the Print Settings tab under the Options menu.

To print annotations, select Print Annotated Topics from under the File menu, or click the Print Annotated
Topics button in the Manage Annotations dialog.

The annotation source file is called [project name] .ann. The annotation file is located in the following
directories:

e For Windows Vista/7/8 and later: C: \Users\<user_logon>\AppData\Roaming\GMCL\DBDOC

¢ For Windows 2000/XP/2003: C: \Documents and Settings\<user_logon>\Application
Data\GMCL\DBDOC

e For Windows NT 4: C: \WINNT\Profiles\<user_logon>\Application Data\GMCL\DBDOC
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2.10 Printing Documents and Groups of Documents
2.10.1 Printing a single document

You can print the active pane by clicking the Print button on the toolbar or by selecting from the various
print options under the File menu. The pane that currently has focus will be printed.

If a dialog box appears asking you if you really want to print an index page, the answer is probably No. This
is just a safeguard in case you have accidentally left the focus on the wrong pane. If you want the content
(graphic or CAD/CLD sheet), make sure the focus is on the content (right/lower) side and print again.
Pages are printed with the drawing name, date and time and custom captions can be inserted. Our caption
feature (in Advanced Options) lets you record a useful comment for this topic that will be printed at the

bottom of the drawing.

Zooming in on a particular area gives you better resolution. A diagram will appear in the lower right hand
corner of the print out, showing the portion of the drawing being printed.

2.10.1.1 Printing options

Various options can be set for printing:
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Any setting changes made here in the print dialog under the Advanced Options (e.g. Suppress automatic

color reversal, Annotations, etc.) will be reflected in the Print Settings tab under Options.

= Printer
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2.10.1.2 Fast Print to use your previously defined print settings
After doing the first print, you can avoid seeing the Print dialog box before each subsequent print by:

1. Selecting Fast Print from under the File menu.
2. Pressing P on the keyboard.

E] Note: The print dialog box choices from the first print will be applied to subsequent prints.
2.10.1.3 Printing selected text

You can select a portion of any text document, including the contents of the index pane, to print. The
Selection radio button in the print dialog box will be enabled.

2.10.2 Marking the current topic for later printing

This option is useful when a large number of topics needs to be printed at one time. You can use the easy
popup menu interface to add a document. Right-click on the document and select the Mark This Topic For
Printing option from the popup menu.

2.10.2.1 Marking the current topic for printing

When you choose Mark This Topic For Printing in a pop-up menu, the current topic will be marked for
printing, and added to the Marked Topics list in the Mark Topic for Printing dialog.

2.10.2.2 Marking a linked topic for printing

If you choose Mark "[document]” For Printing in a hotspot pop-up menu for a hotspot in the index pane
than links to a document (for example, a graphic), the linked topic will be added to the Marked Topics list.
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On the File Menu, click Mark Topic For Printing.... This displays the Mark Topic for Printing dialog.
2.10.3 Using the Mark for Print dialog to print groups of topics

The Mark for Print feature allows you to "mark"” or select a topic or group of topics for printing. The marked
topics are stored in the Marked Topics list shown in the Mark Topic for Printing dialog. Once topics are in
the list, they can be printed en masse. This feature allows you to easily collect topics for printing as you are
browsing, and also to print all (or some) topics of a certain type, for example CAD sheets, BATCH files, or
topics with annotations, without having to view and select each topic individually.
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2.10.3.1 Marking a group of topics for printing
In the Mark Topic for Printing dialog,

. Select All Topics in Group from the Mark Menu.

. Select a group of topics from the Groups Menu.

. Click Add

. Make sure the the desired group has been added to the Marked Topics list box, and items to be
printed are checked off. The topic groups in the Marked Topics list box are expandable, and
individual items can be unchecked if you do not wish to print them.

5. If you wish to print the topics in the Marked Topics list now, click Print Topics.

AW DN =
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2.10.3.2 Removing topics or groups of topics from the marked topics list
In the Mark Topic for Printing dialog,

1. Select the desired topic or group to remove by highlighting it in the Marked Topics list box.
2. Click Delete to remove the highlighted group or topic.

OR
1. Click Delete All to remove all items in the Marked Topics list box.
2.10.3.3 Other options
In the Mark Topic for Printing dialog,
* Remove all topics from Marked Topics list after printing: General topics shown in the Marked
Topics list are cleared when the dialog box is closed if they have been printed.
e Enter/modify caption for selected topic: Allows you to create or change a caption for the selected

topic. Use this option to include comments about the topic; the drawing title is printed automatically
above the caption.
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2.11 Sharing Data with Other Hyperview Users

2.11.1 Overview of User Data Sharing

Choose Options in the main menu to open the Properties for Hyperview dialog. Click the Sharing tab to
display the Hyperview data sharing settings.

Certain user data can be shared "live" among users. For example, the stars and checks with which one user
marks errors in the Error Browser can be displayed in the another user's Error Browser.. Sharing is not yet
supported for all user data, but over time support will be increased. Eventually annotations, live loop
annotations, and watch window groups will all be able to be shared easily among users.

When you run Hyperview, your personal user data files are stored in a hidden folder. When you enable data
sharing, some of these hidden data files are copied to a central repository, the Shared Data Folder where
they are available to other Hyperview users. The data in them can then be displayed in Hyperview browsers
belonging to other people.

2.11.2 Specifying the Shared Data Folder

In order to share user data, a Shared Data Folder must be specified. This can be any folder on your network
file system to which all the sharing users have read and write access. Usually the name of this folder will be
built into the project file in BuildPlus, and you won't need to change it. But if it is not built in, you can specify it
here.

Shared Data Folder

Choose the shared folder where data from you and other (~ |50 Project File Default
users will be copied. Momally this is specified in the =
project file, and can be left unchanged. * Choose Folder

|"-."-mau:lder"-.F‘uI:uIiu:"-.Shared Data Browse. ..

2.11.3 Updating your user information

You can specify or update your first and last name, and enter a note. Other users will see this information. If
you leave these fields blank, other users will still be able to see your username and computer name.

Basic Information

Computer: [LEGOLAS

Usemame:; |L‘.‘.1'1&ril}ﬂ

First Mame: |

Last Mame: |

Mate: |
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2.11.4 Specifying what sorts of user data to share with others

In this area, specific which data you want to share with other users. For example, if you don't want to let
others see your error information, but still want to see theirs, just uncheck Error Stars & Checks.

Diata to be Shared with Cthers

Specify which types of data you
will share with other users.

[+ Emor Stars & Checks

2.11.4.1 Specifying whose data to include by default

You can specify the users whose data you wish to include by default (and override this default elsewhere if
you need to).

Users Whose Data will be Included by Default

m‘-‘? K Whﬂgﬂf d;*;;;“ . YOU: Cherilyn on LEGOLAS
you miaHypazfvli:wum:zreﬂ?m.ane [+] Jane Jones (Person on LEGOL...
machine, this is an easy way of [v] John Smith (Person on LEGOL...
automatically combining your data from

these different locations. You can

ovemide this default alsewhens
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2.12 Tools, Reports and Indexes

2.12.1 Viewing the resources used in a drawing with the Audit Window

You can use the Audit Window to view the resources used in a CAD/CLD or graphic. This includes:

¢ Block and tag usage

e Input and Output references
¢ Function blocks

e Graphics / document links

You can open the Audit Window by either selecting it from under the View menu, from the popup menu on a

right mouse-click, or the button on the toolbar.

a
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B the document

2.1 Sousce i ' are listed here
i | \;q‘-llu ani

Expaied ey ey .

4 bogal.ixi i ml

41 Tag Namd Click on an item "’,,.'I _______
5 bogaiau to highlight it on
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& GIF.DR (HF D 51

52 Aarm g - AD/L
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Hyperview will highlight the selected target from the Audit Window and zoom in to the appropriate level. You
can save the Audit Window contents for printing or editing later.

¢ Select File then Export

e Or print them now with File then Print

¢ You can print or export the whole list or just the individual parts of the list, i.e. the Blocks, Tags,
References, or Function Codes. There are also various formats in which the list can be printed or

saved, allowing you to get the information in a format that best suits your needs. A default name will
also be supplied.
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Below is a drop-down menu for Audit Window/File/Export:

@‘ [i90 demo daily build_20240401a_w2024-03-29-96460.dbdoc] Audit Window f

File
Export ¥ All {In Separate Files)
Print Blocks
Close Tags
- Q_Tags{ﬁ} il Function Blocks
E|-:E.‘- References References .
----- -:EF HEBASLL Yirks bck 637
----- I [ e ———— —tck 637

----- i HBAT325 HIGH — Input Reference wired from block 3764
.= HBAT325 LOW — Input Reference wired from block 3766
Ldml HBAT325 | OWER — Input Reference wired from block 1537

Why do you want to use Audit Window?

e Checklist for tags

¢ All places a block is used on the CAD/CLD or graphic

e Verify that a block is used consistently

¢ See the tags on an AutoCAD or MicroStation sheet

e On graphics, determine if the uses of a tag are spread across the page

2.12.2 Using PCU Map to understand interactions among PCUs
The PCU Map shows you the interaction between PCUs, listing what blocks are exported and imported

between two units. Access the PCU Map from the System Information chapter by clicking on "PCU

Interactions (Block Imports and Exports)". Click on the PCU Report Page link to bring up a table similar
to the following:
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Click on a link in the table to bring up the specific block interaction between two chosen PCUs.

Interactions between PCU 2,02 and PCU 2,01

PCU 2,02 exports to PCU 2,01

Exported Point Module 2,02,20 Block 9565
Imported by Module 2,01,10 Block 4286

Exported Point Module 2,02,20 Block 9567
Imported by Module 2,01,10 Block 4285

PCU 2,02 imports from PCU 2,01

Module 2,02,20 Block 5419 gets value from Module 2,01,20 Block 127
Module 2,02,20 Block 951 gets value from Module 2,01,20 Block 177
Module 2,02,10 Block 5519 gets value from Module 2,01,20 Block 36
Module 2,02,20 Block 9542 gets value from Module 2,01,10 Block 4298

2.12.3 Graphical Block Map: a graphical overview of block usage

Block map is a graphical overview of block usage, showing configuration aspects and issues at a glance.
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The Block Map can be accessed by either:

¢ Clicking on the Block Map link available at the beginning of each chapter of CAD/CLD sheets.
¢ Right-clicking on a CAD/CLD Sheet and selecting Go to Block Map from the popup menu that
appears.

+ If you right-click on a specific block, the corresponding module block map page will be
brought up in the content pane and the Table of Contents will display the Block Map Index
for the module. The selected block and appropriate block range will be highlighted by Vegas
Lights (if that option is turned on under the Highlights menu).

+ If you right-click while on white space on the CAD/CLD Sheet, only the Table of Contents will
be updated to bring up the Block Map Index for that particular module.

Explanation of the Block Map color legend:
[US&d] _ (Green block) This block is used.
- = (Red Block) This block is used in configuration but the source does not exist (or is not built.)

- = (Orange Block) The block is used on a graphic, but not sourced in configuration.

= (Pink Block) This block is referenced in a database, but not sourced in configuration.

[No Source (NS) | (Purple Block) This block does not have a source, but is sourced somewhere in the
system.

[Exported () ] _ (Blue Border) The block is exported, but not tagged.

= (Black border) The block is tagged and exported.

81


http://wiki.gmcl.internal/w/File:Block_index.jpg
http://wiki.gmcl.internal/w/File:Green_block.jpg
http://wiki.gmcl.internal/w/File:Red_block.jpg
http://wiki.gmcl.internal/w/File:Orange_block.jpg
http://wiki.gmcl.internal/w/File:Pink_block.jpg
http://wiki.gmcl.internal/w/File:Purple_block.jpg
http://wiki.gmcl.internal/w/File:Blue_border.jpg
http://wiki.gmcl.internal/w/File:Black_border.jpg

= (Yellow block) The block is tagged, but unused.

= (White block and border) The block is completely unused.

Ideally, what you want to see for your blocks is: -

A green block with a black border is a "perfect tag" - tagged, exported and used. The Block Map allows you
to see where blocks are available for insertion of a large function code.

2.12.4 Tag Index: an alphabetical index of all the tags in your system

The Tag Index is an overall view of all the tags in all your databases.

== ————————— '
Tag Index - - -
g Tags beginning with F
Tags beginning with 0
Tags beginning with 2
I:g: E:g:z::zg :::: : Tagname ¢ Tag Description v 190demod
Tags beginning with & FIZ050 TOTAL AIR FLOW STAGE | 1,03,03,1718
Tags beginning with A FIC000 ELOWER AERN FLOW SP & PV ADD 1,03,03,8816
Tags beginning with & FIC3001 PRE-AERATION 142 AIR FLOW 1,03,03,6210
Tags beginning with C
Tags begianisg with D FIC3002 PRE-AERATION 3&4 AIR FLOW 1,03,03,6310
2 haginningwith E, FIC3003 AERATION CHANNEL AIR FLOW 1,03,03,6410
| beginning with F FIC3004 GRIT & INLET CH. AIR FLOW 1,03,03,6710
Tags DeEnng with G FORCOOD VAP T8 GOVERNOR VLV POSITION 1,00,02,2105
Tags beginning with H
Figs Bagianieg withi| FT10016 SLUDGE GAS FLOW 2,10,03,6160
Tags beginning with K FTAAHT1S VAP TURBINE INLET PRESS HI 1,01,02,2137
Tags beginning with L FTAAHT 21 HF VAP TURE INLET PRESS HI 1,001,02,1433
Tags beginning with M FTAAHI49 PROCESS VAPOR PRESS HI 1,01,02,1531
Tags beginning with N

The Tag Index is found in the Database chapter in the Table of Contents. It is comprised of an alphabetical
and numerical listing of all the tags in your system. Each tag database is a column and each tag is a row. If a
tag is present in a database, it will appear in the appropriate column, with its associated Loop, PCU, Module
and Block information. The LPMB information is a link that you can click on that will take you to the
corresponding Block Index page. If the tag is not present in a database, the text ABSENT will appear in the
column.

Tips for using the Tag Index:

e For quick loading, switch to Treeview Table of Contents mode (press Ctrl+ T).

¢ When you click on a Block Index link, it will highlight the first reference to that block, not the one that
you clicked on.

¢ The database column headers are not repeated but the databases are in the same order as in the
Table of Contents (alphabetic).
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2.12.4.1 Using the Tag Index
To find inconsistent LPMB in your tags:
¢ Do a Full Text Search in current topic for Exact Match for ++.
e Inconsistent tags appear in red and are preceded by the text ++.
e In DBDOC_TAG_MISMATCH.ERR, look for the Tag mismatch for X: see TAGMAP for details.

To get a list of all tags in your system:

e Select and print the individual Tag Index pages.
e |f you have more than four databases, set your printer to use landscape orientation.

To walk through the Tag Index pages:

e Click on the first letter combination and page down to see all the tags in that section.
» Type B for browse to see each section.

D Note: You can also locate these graphics and symbols by looking at the Undefined Tags, Missing
Graphics, and Missing Symbols or Submodels lists located in the System Information chapter of the

project.

e For quick loading, switch to Tree View Table of Contents mode (Ctrl+T keys).

e When you click on a Block Index link, it will highlight the first reference to that block, not the one that

you clicked on.

e The database column headers are not repeated but the databases are in the same order as in the

Table of Contents (alphabetic).

Find inconsistent LPMB in your tags:

¢ Do a Full Text Search in current topic for Exact Match for ++.
e Inconsistent tags appear in red and are preceded by the text ++.
¢ In DBDOC_TAG_MISMATCH.ERR, look for the Tag mismatch for X: see TAGMAP for details.

Get a list of all tags in your system:

e Select and print the individual Tag Index pages.

e |f you have more than four databases, set your printer to use landscape orientation.
e Walking through the Tag Index:

e Click on the first letter combination and page down to see all the tags in that section.
* Type B for browse to see each section.

e For quick loading, switch to Tree View Table of Contents mode (Ctrl+T keys).

e When you click on a Block Index link, it will highlight the first reference to that block, not the one that

you clicked on.

¢ The database column headers are not repeated but the databases are in the same order as in the

Table of Contents (alphabetic).
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Sort columns in the tag index:

The columns in the tag index can be sorted either ascending or descending alphanumerically. When you
mouse over a column it will be highlighted, clicking anywhere in that region will change the sort of the
column. The current sort mode is indicated by the arrows to the right of the column name. When the down
arrow is highlighted in grey, the column is currently sorted in descending order. When the up arrow is
highlighted in grey, the column is currently sorted in ascending order.

2.12.5 Graphics Cross-Reference Window: index of all the graphics that link to and
from the graphic, plus included symbols

The Display Cross-References option displays an index of all the graphics that link to and from the graphic
as well as symbols included in the graphic. This tool also shows symbols individually and any graphics that
include the symbol. The Cross Reference Index page for a particular graphic provides information similar to
the Audit Window except across the whole DBDOC system. When building your project, in the BuildPlus
Project Options, choose the Advanced Options on the Processing Options page and make sure the
Exclude Symbols and Submodels chapters from build is unchecked to get full symbol cross references.

Accessing the Cross Reference Window while on a graphic:

® Click the Display Cross References button
¢ Under the Go menu select Display Cross References

e Type X on your keyboard

B 20Deme_20180202b_wi2(18-02-02-81454.dbdec -- Operaters Graphics -- G41.0R (G41) - O x
File 5
B | o 64108 (641) (click here to return) A% aAy o BepE LB OD
i =1 Graphics which link to 541,08 (541) b3 S
G4 G30.0R [DUMP COMDEMSER)
Gl G46.DR (WASTEWATER TREATMENT 5¥5)
= Graphics linked by G41.0R {G41)
L¢ 39.0R (DURP COMDEMSER)
343 (not bnked)
Bd 544 (niot Enked)
G46.0R (WASTEWATER TREATMENT 5¥5)
M' G50 (not Bnked)
10 =1 Symbels included by G21.0R (G41)
10 AVLYUIDODY (not lnked)
10 AVLVUS0DY (net lnked)
o BOM00UDY (mot fnked)
10 DARDWISODY (not linked)
: g DCSHPOP.DY (not lnked)
10 HLDY (ot linked)
10 HH.DY (met Enked)
10 L% (ot linked)
10 LARCWID0.DY (not linked)
10 LARCW150.0Y {nat hinked)
10 LLDY (net linked)
: g LOWPR.DY {not linked)
S E w
101020 ?A.E':‘fﬂlnm Nnked b I
»
02-Mar-2018 2:24 PM | DEV wB15860  0.00% 31792821  Customn Settings [Send/s0.00 Recw/s:0L00] Data Files [11.46] ‘nﬂ. 10102024
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A separate floating window will be opened showing you the different Graphics Cross References categories,
handily displayed in a tree view:

The position and size of the Cross Reference Window will be retained between runs so that you do not
need to reset them to suit your preferences each time the feature is used. The window will remain open while
you navigate to different documents in your project file until you choose to close it or open up a different
project file.

You can always return to the original graphic referenced in the Cross Reference Window if you have moved
onto different documents by clicking on the "(click here to return)" link at the top of the tree.

This feature can be used to cross-check a number of things in your system:

¢ Find out which user symbols are no longer used by your graphics

e Step through your symbol chapters

e Bring up the cross-references for each symbol

e Symbols that are never used will have a blank cross-reference page

e | ocate graphics not being built but are still being linked to

e Step through your graphics chapters

¢ Bring up the cross-references for each graphic

¢ Black entries (no hotspot) in the Cross Reference Index indicate that DBDOC was unable to build
the graphics called for; either the build was incomplete or some of the graphics are trying to link to
graphics that no longer exist

2.12.6 Function Code Descriptions and Uses: an index of all the function codes in
your system

The Function Code Descriptions and Uses index is located in the Table of Contents. Click on Function
Codes under System Information. There are three columns of links in this index.

1. Function code name, e.g. ADAPT: items in this column link to the documentation for the function
code, including basic spec and output descriptions.

2. Function code number, e.g. [FC24]: items in this column connect to the corresponding entry in the
numerical function code index. Usually you would come at them from the other direction, via the
Function Codes by Number index in the main table of contents.

3. Function code uses, e.g. USES(45): this item brings you to the function code uses index, an index of
all the CADs or CLDs where that particular function code is used. Items in this index are linked to the
function code hotspots on CAD sheets.

Function Code Descriptions and Uses

< [FC11]) USES (1) Low Select

= [FC10] USES (2) High Select

A [FC2] USES (110) Manual Set Constant
A-INT [FC52) USES (40) Manual Set Integer
ADAPT [FC24] USES (45) Adapt
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The link FROM function code hotspots to CAD sheets back to the function code index is disabled by default.
In the disabled state, clicking on the function code number will not take you to the function code uses index.

Function Code Hotspots can be turned on or off via the Enable function code hotspots checkbox on the
View tab of the Options dialog (in the main browser menu). You can also turn on the option by left clicking
on a function code hotspot position that will bring up the following dialog:

You can choose to:

e Enable the hotspots

¢ Disable the message box from appearing again the next time you click on a function code hotspot
position

¢ Do nothing at all by clicking OK without checking either option or clicking the Cancel button

2.12.7 Function Block Index: a list of all the function blocks used on a CAD/CLD

The Function Block Index lists and links every function block on a document. You can display it by clicking
on any function block on a CAD or CLD. If function block hotspots have been disabled, this index will not be
shown. See Enabling function block hotspots for information on how to enable and disable function block
hotspots.

Function Blocks Used on 1010247A.CAD s e

Al/B: Analog Input {(Periodic Sample) [FC25]
1 mModule 1,01,02 Block 1033

AO/L: Analog Exception Report [FC30]
Module 1,01,02 Block 1513
Module 1,01,02 Block 1532
Module 1,01,02 Block 1534
Module 1,01,02 Block 1535 I FTAT349 [Fe1)
Module 1,01,02 Block 3716 il — gl i)
Module 1,01,02 Block 3730

DOJ/L: Digital Exception Report [FC45]

1 Module 1,01,02 Black 1511 " ; [FC3z]
2 Module 1,01,02 Block 1530 | ADSL e
3 Module 1,00,02 Block 1531

4  Module 1,01,02 Block 3719

el
ted

[- . I T

W

[0-300 KPAS) FTALIZ4%

F(X): Function Generator [FC1]
1 M@-ﬂuLE-l "Jl.-CL..-Elﬂ:If.k-l-iﬂi

HHL nghfLuw Compare 19 i Y |

1 Module 1,01,02 Block 1506 —|HHI 348 ()
2 Module 1,01,02 Block 1508 j 1032 [FLis 1505
3 Maodule 1,001,02 Block 1514 J {g-1200 F}

4  Module 1,01,02 Block 1516

S R: Memory [FC34]
1 Module 1,01,02 Block 1510
2 Module 1,01,02 Block 1518 s

2.12.8 Graph of F(x) (Function Code 1)

INFI 90 Function Code 1 implements user-specified piece-wise linear functions. Hyperview displays a sketch
of the function in the function box when specs are visible (hint: use the S key). Right-click on the block
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number and select Create Live Function Graph for this Block to get a larger, resizable, movable graph.
Example of a Function Code 1 Graph:

/ Live F(x) Graph for 1,1,2 Block 1360 ﬂ

[ ]
1485,1.467 (512,513)

/ TP 1Saf | a3 L2 b )
] -I. ) k ' L II..

[FCAl 3

— Slpel F(X) =
1360 B[—1297.24.1.178
T i ey D TR R AN ey

14.48 1.002 (52, 53)

Input: Block 3723

You can print any particular graph by clicking on the print button in the lower right hand corner. The
graph will be printed full-page size.

The graph plots the spec values that define an input-output function. In version 10.4 and newer, the input and
output values are also plotted directly on the graph, and are updated at the same rate as the underlying
document. You can force a data refresh by clicking the refresh button in the graph window.

2.12.9 Adapt Block

Follow the link for Function Code 24 from the FUNCTION CODE INDEX to all the instances of Adapt Blocks
in your INFI 90 system. You can easily go from the Adapt Block to the block it adapts (or the other way
around), even if they are on different pages. Live monitoring will show the adapted spec in grey on an adapt
block. Adapted specs are further marked with a right angle bracket beside the spec (>).
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2.12.10 Rung Block Display

Rung blocks are heavily used in some systems: turbine control systems designed by ETSI, for example.
When specs are visible, Hyperview displays a ladder diagram that describes the function of the rung block.
Live monitoring will show which inputs are open and closed, plus the output.

| _ 522 [Feiiz] | | QL1 20, [Fc112]
— 523 RNG20 0023y fHG2 oLl
524 4086 0024, 4288
:—\ L 5112 _l._':l [ ¥F]
__s26p ::“ _@EI%*-.;.‘. g
IR by [ 1m 37y,
EEPEy: | 000 25|48
Ly 0029
'__-"'_'sz ___'" E¥|
5 8 _J-._ilh.
=¥ _lil c37 53
i i 22w
:_‘_ii-'-'sz q_ii.'
;\_5_4.'-';3 _j_d‘.‘
E AL T S D o

Forced outputs are shown in Version 9.60 and later.
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. 5?. [FCc11o]
59 6259

Hyperview will display 0, 1, H or ? in a red box after the output.

2.12.11 AutoCAD and MicroStation

AutoCAD and MicroStation drawings are useful to have in the DBDOC build. Viewing them in Hyperview is
much easier than working with large stacks of sheets. Where the INFI 90 tag name is on the drawing or can
be constructed from data in attributes, there will be a direct link to the tag in the CAD/CLD sheet and on
graphics. Live information can be displayed on these drawings. Links are also constructed based on a partial
text phrase match algorithm that can be activated in the BuildPlus Project Options. We can customize the
way we identify tags so if you are not getting the links you want, please contact us.
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2.13 Managing Live Loop Connections

2.13.1 About live data settings

Live data can be displayed on documents in Hyperview and plotted in the Watch Window. This data must be
fetched from your system, generally from a CIU. A DBDOC data server called ClUMon talks to both
Hyperview and the CIU, and transmits data requests and responses.

Different systems have different configurations for live data. Some have one CIU, and some many. Some
have serial port modules available. Some have CIUMon servers running in relay mode located on an
intermediate LAN to provide NERC compliant live data to the Business LAN.

Hyperview needs to know what data servers to talk to. Generally this is specified right in the project file (built
by BuildPlus during the build process). The live data connections can also be specified from inside
Hyperview.

Your live data settings have probably already been configured, built into the project file. If no settings are built

into your project file, or you need to change or override the built in settings, you can create custom settings in
the Live Loop Settings tab in the Options dialog.

2.13.2 About the Live Loop Setup dialog

Properties for Hyperdew B;H

Vew L Locp Set | Colors | Print Seinge | Sharing

&
1% Shew cma ko) data

[ Save dems deta in kegs:
™ Lse local settings

Na ClLikon patirige: fusng demo data)
Hesstrane o 17 Ped | St Il;‘:l;e:"-l_u_:;d-‘;f_

The Live Loop Setup dialog is the control center for managing and monitoring your live loop setup. This is
where you can see what ClUMons Hyperview is connected to and whether there are any connection issues.
Although the current version of Hyperview automatically routes data requests to be best placed CIUMon, it is
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also possible to force requests for particular loops or PCUs to be sent to a specified CIUMon. If a serial port
module is available for a particular PCU it will be used automatically for requests for that PCU.

In general, your live loop configuration will be determined by your DBDOC administrator and built into your
project file. If this configuration has not been defined in this way, or you wish to override it, you can create a
custom live loop configuration in this dialog which can include ClUMons of your choice, or force certain
ClUMons to be "ignored" by Hyperview.

Ej Note: You can see an icon representing the status of your live loop connections in the Live Data Status
Bar.

2.13.3 Choosing a settings list

+)

Lize a CllUMan settings list from the project file

" Choose list: [ Man list 2 J
* Let Hyperview choose the list automatically (Cumently trying "ClLUMon kst 2)

Show demo fake) data
I [

-

" Use local settings

Live loop configuration is handled a bit differently from before starting with Hyperview 10.4. As before,
settings can be built directly into the project file by your DBDOC administrator, but now it is possible to group
the ClUMons into different lists based on what network context the CIUMon is located in. For example, many
sites have one or more CIUMons running on their DCS LAN which are accessible to Hyperviews on the DCS
LAN, but not accessible to Hyperviews on the business LAN. Those sites might add a second settings list
that included a CIUMon running in relay mode on the business LAN.

You can choose among project (dbdoc file) settings, custom local settings, and demo data.

Use a CIUMon settings list from the project file

The settings lists built into the project file can be seen in the drop-down under Use a CIUMon settings list
from the project file. Usually there will be only one list, but it is possible to build multiple lists into the project
file. Your DBDOC administrator might do this in order to specify different CIUMons to be used in different
network contexts. Hyperview will try to choose the correct list for you (based on which ClUMons it can
connect to), but you can override this choice manually.

Show demo (fake) data

Use this option to test the visual display of live data when your Hyperview is not hooked up to a CIUMon.
You would never use this option under normal circumstances.

Use custom settings
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This choice allows you to define a local persistent CIUMon list. Use it if there are no settings built into the
project file, or if you want to create different settings. Pressing Copy from project file will re-initialize the
custom settings to match the currently selected project file settings. If you want to create custom settings that
are similar to the project file settings, that's a good place to start.

2.13.4 Understanding your current live loop settings

The list of CIUMon servers that Hyperview is currently connected to (or trying to connect to) are displayed in
CIUMon Settings. If you select a different server list as described above, a different set of servers will be
displayed here. In general this list of servers will have been preconfigured at the build stage, and built into
the project file. More than one list may have been built into the project file (typically to support fetching live
data in different network contexts). In this case Hyperview will generally have selected the appropriate list
automatically.

Each CIUMon server in the list is connected to either a ClU, a Serial Port Module, or another CIUMon server
(in relay mode) which is ultimately connected to an actual CIU or SPM.

Unlike in previous versions of Hyperview, it is not necessary to specify in Hyperview which loop a CIlUMon
server is connected to. CIUMon reports its loop connection directly to Hyperview, and data requests are
routed appropriately. The self-reported CIU location is shown in this dialog.

List of ClUMons this The ClUMon on asclepius
Hyperview is connected t0.  port 5099 is connected to a
CiliMon /e“-mga: CIU on Ljuﬂp - &
Lm:aﬁm | Part | Status / | Logal port | Used for |
azclepius A099 Connected to loop 3 . 5100 B, 15971 Dk e o
loops are being routed to
this ClUMon.
The CIUMon on locahost Each connection to a
is blocking this user. ClUMon uses a local
[ port.
Add | | |

Location and Port

This is the computer and port that a CIUMon server is running on. Hyperview makes a connection to the
CIUMon at that location. This is the only information about a ClUMon server that Hyperview needs to know.

Status
This column shows the current status of the CIMon connection, whether it is connected, not connected, or
blocked. If Hyperview is connected to a version 10.4 or later CIUMon, CIUMon will self-report which loop it is

connected to, and that information is displayed here. Similarly, if the CIUMon is connected to an SPM to talk
to a specific Loop and PCU, the PCU number will be shown here.
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Ej Note: If Hyperview is connecting to an older CIUMon (pre 10.4), that CIUMon will not self-report its CIU
location. In that case, the CIU location information can be provided manually via Routing Preferences (see
below). When ClUMon settings are converted to version 10.4, routing preferences are automatically created
for unusual cases, and you can also create them manually if neded. This should rarely be necessary.

Local port

This column indicates which local port on the Hyperview computer is being used to make the connection with
the CIUMon server. Normally it is chosen automatically from the default port range, but it can be specified
when a connection is defined, or a non-default port-range can be specified.

Used for

This column shows which loops are having their data fetched via that ClUmon. For example, if "3" is in this
column, it means that data requests for Loop 3 are going to that particular CIUMon server.

2.13.5 Adding or modifying live loop connections

2.13.5.1 Adding a connection

To add a new live loop connection to a ClUMon server, press Add beneath the server list. The Add ClUmon
dialog will appear. Specify the location of the CIUMon server Hyperview needs to connect to.

Ej Note: You can only add, edit, and delete servers that are part of a Custom settings server list. You can't
change a server list that is built into the project file.

s Ny
Add CIUMon |

CIUMon lecation
Hostname or IP: | hostname

Port: | 5099

Connection options

[T Force Hyperview to use a spedfic local port

Local port:

oK Cancel

Hostname or IP

Specify the name (or IP number) the of the computer on which the CIUMon server you wish to connect to is
running.
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I Note: To indicate that the desired CIUMon is running on the local machine, use 127.0.0.1. Generally
localhost will work as well, but this depends on your hosts file being configured correcily.

Port

Specify the port that the CIUMon server is listening on. By default this is 5099, but if a CIUMon server on
your system has been configured to listen on a different port, you must specify that port here.

Force Hyperview to use a specific local port

Allows you to specify which port will be used locally for communications with the CIUMon server. It is usual to
leave this blank, and allow it to be selected automatically from the default port range (or specified port range),
but under some circumstances it may need to be set explicitly.

Local port

If you are forcing Hyperview to use a specific local port by checking Force Hyperview to use a specific
local port, you must specify the port number here. You might do this if your Hyperview can only use one
specific port through your firewall.

2.13.5.2 Editing a connection

To edit an existing live loop connection, select the connection in the ClUMon settings list and press Edit.
The Edit ClUmon dialog will appear. Make the changes needed and press OK.

2.13.5.3 Deleting a connection

To delete an existing live loop connection, select the connection in the CIUMon settings list and press
Delete.

2.13.5.4 Ignoring a connection

To "ignore" an existing live loop connection, select the connection in the CIUMon settings list and press
Ignore. Functionally this is identical to deleting the connection. When routing data requests, Hyperview will
act as though that connection did not exist. However, it is temporary, because an ignored connection can be
unignored and reinstated. If for some reason you want to force Hyperview to never send requests to a
particular server, you can "ignore" it.

2.13.6 Specifying a non-default local port range

Local port autobind range

{* |Jse default port range [5100 to 5200)

" IJse custom port range
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By default, Hyperview will assign a local port to a CIUMon connect automatically, choosing an available port
from within the default port range. Unless you require specific port behavior, for example due to firewall
constraints, it is best to stick with this default.

To specify a custom local port range, check Use custom port range and then specify the range.

Ej Note: You can only specify a custom port range for a Custom settings server list.

2.13.7 Adding routing preferences

Normally data requests are routing to appropriate servers automatically.

In the event that you want to specify that requests for a particular loop or loop-pcu combination should be
routed to a particular server, click on Routing preferences.

I Note: If Hyperview is connected to a pre-10.4 ClUMon, the ClUMon will not self-report the location of the
CIU it is connected to. Use a routing preference to specify this location if needed. The CIUMon will otherwise

be assume to be connected to a CIU on Loop 1.

To add a routing preference, click on Routing preferences to bring up the Add preferences dialog.

Add preferences [&J

To force requests for a particular Loop and PCU to be directed to a
particular preferred server, specify the Loop and PCU here,

Loop
PCU v Al

MOTE: If a PCU is spedfied ("All" is unchecked), and the
preferred server is CIUMon 10.3. 1 or older, this CIUMon must
be configured as an SPMO2.

| Cancel |

Specify the loop (and PCU, if applicable) you wish to make a routing preference for.
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Set preferences |5

Servers bo by first for loop 3 [all PCUs)

| Localion | Port | Using | Metwo

ORI

Ok, | Cancel

Choose the ClUMon server to which data requests for that loop-PCU should be routed.

Routing Preferences @

Hyperview ties to choose the best connection for each data request
autaratically. Optionally, uze the settings here to change this.

If & loop has prefered connections here, Hyperview vl tiy them first,

Loops with prefered connections;

Loop | PCU | Preferred connections | Using
3 Al archimedes: 5033

Add [

1)1 | Cancel

You can also edit and delete existing routing preferences.

2.13.8 Unavailable data

|Inavailable data:

[hiore]

If data cannot be fetched for a particular loop or PCU, the loop and PCU are displayed here. If live data
monitoring is turned on, but there is no CIUMon connection established, there will be items in this box. This
could also happen if the only CIUMon available is connected to a serial port module on a certain PCU, and
data is being requested for a different PCU.
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2.13.9 Status of live data connections

It's easy to see the current status of your live data connections. Just look at the network icon in the
Hyperview status bar.

Connection OK (Project CIUMon is connected using project file live data settings, communications
Settings) are happening, user is not blocked

Connection OK
(Custom Settings)

CIUMon is connected using local custom settings, communications are

happening, user is not blocked
Unable to connect Cannot communicate with specified connections

No connection
specified

] [s] (5]

No connections have been specified in the Live Loop Setup options dialog

User is not allowed to collect data on any of the specified connections --

Connection blocked
they have been blocked by the DBDOC administrator

=] @]

Demo settings Demo data is being displayed, not data from ClUMon

2.13.10 Compression of Hyperview data requests

¢ Hyperview examines basic Loop, PCU, Module, Block (LPMB) information and combines requests
before sending it out to CIUMON.

e |f two people are using Hyperview to monitor the same set of points, will CIUMon will only pass on
one set of requests to the CIU.
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2.14 Managing Live Data Load

2.14.1 Overview of live data bandwidth limitations when fetching live system data

Until recently, the live data fetch rate available in most systems was very low, about 10-20 values per
second. DBDOGC, along with other system applications, was subject to this very low data bandwidth.

DBDOC 10.4, when used with the RoviSys Turbo, changes this picture. When used in conjunction with the
RoviSys Turbo, DBDOC achieves peak data fetch rates of over 100 values per second, and routine data
rates of more than 30 values per second when fetching data continuously.

Before DBDOC 10.4, a DBDOC installation might have used a RoviSys Turbo to interface with a Composer
CIU, or to multiplex a CIUMon server with the CIU connection of an existing EWS. With DBDOC 10.4 the
RoviSys Turbo can be still be used for these purposes, but it can also be used with all ClUs (including older
ICI01 ClUs) to increase data fetch rates by a factor of five or ten.

Despite this groundbreaking improvement in live data availability, bandwidth is relatively speaking, low. You
need to be aware of the very limited live data fetch rate available in most systems, and techniques to avoid
overwhelming the limited capability as you use live data display and trending features in Hyperview. When
multiple users of Hyperview all fetch live data from the same CIU, they share the bandwidth available, so if
that is the case in your system, you need to be doubly aware.

The good news is that the extra bandwidth provided by DBDOC 10.4 and RoviSys Turbo make it much
easier to use DBDOC's Watch Window for data trending without overwhelming capabilities of your system.

Read on for critical information about the following:

¢ How to tell how much data is being fetched by your Hyperview browser.
e How to manage the Watch Window data load in Hyperview.
¢ How to manage the data load of live data display in Hyperview.

2.14.1.1 Constraints on live data fetch rate
Fast facts:

¢ A single CIU without RoviSys Turbo gives fewer than 20 values per second to the entire world of
DBDOC.

e Multiple ClUs without RoviSys Turbo can give fewer than 20 values per second each.

e A serial port module can give DBDOC as many as 80 values per second from the PCU it is serving, a
capability that very few are using.

e The updated RoviSys Turbo uses an optimized fetching and polling strategy, and has been clocked
at over 100 values per second in the field, and routine data rates of over 30 values per second. This
is a vast improvement, but still quite constrained.
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Ways to increase the bandwidth available:

¢ Use the RoviSys Turbo in conjunction with DBDOC 10.4 in order to increase your data fetch rate by
a factor of five or ten.

e Multiple CIUMon processes multiplexed to each of your EWS ClUs will give you more data. Use
RoviSys Turbos to multiplex CIUMons to EWS ClUs.

¢ |f you have a small number of PCUs, multiple serial port modules will give you a great deal more
data.

CIU setups and how they affect available bandwidth:

¢ Single CIU — A single CIU should probably be on Ring 1, unless it cannot be, or unless the main
system is not on Loop 1. Be aware of the extra load of bridging from one loop to another, which has
to be done by way of Ring / Loop 1. If you have only one CIU available for DBDOC, you are limited to
the base 10-20 values per second, unless you also use the RoviSys Turbo to optimize data fetching.
Using this extra software will increase your data rate to 30-100 values per second.

¢ Multiple ClUs — You may have more than one EWS, and each might be on a different Loop. It is easy
to take advantage of DBDOC CIUMon and RoviSys Turbo. We encourage you to multiplex any EWS
ClUs you have. For 10% to 20% of the cost of a CIU, you can have its spare bandwidth available for
DBDOC. It is simple to implment and easy to reverse or suspend.

e Serial Port Modules — The Serial Port Modules are of immense value when used with DBDOC. Each
is capable of giving up to 80 values per second from the modules in a PCU. Of course, you have to
be satisfied that this does not load the PCU too much, but being on top of that is a manageable
problem. As all the data from any PCU with its own Serial Port Module is offloaded from your ClUs,
the system directly gains throughput, too.

2.14.2 Managing live data load
2.14.2.1 Managing data load for live data on documents

Tips for minimizing your bandwidth needs:

® Slow mode IEI should be used (not Continuous mode ) unless continuous data is necessary.

CIUMon [Send/s:7.19 Recv/s:5.93] WW Data Files [856.1M] | a8}

¢ Be aware of the Send/s and Recv/s fields in the Live Data Status Bar at the bottom of the
Hyperview browser. These indicate how many data requests Hyperview is making per second, and
how many data updates it is receiving.

¢ Be aware that unlike live data on documents, the Watch Window collects data even if it is closed or
hidden.

If you use Continuous mode live data display on documents:
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e On documents, live data is fetched for all visible points. If you are zoomed out on a graphic, and
monitoring in Continuous mode, this can place a heavy load on the system. Zoom in on graphics.

e Better yet, avoid Continuous mode live data on graphics — save it for CAD/CLD diagrams!

e Make sure the default update interval for live loop annotations is no smaller than it needs to be. The
default update interval can be specified in the Options menu on the Hypervew browser.

¢ Be aware that your data collection activities affect the bandwidth available to other Hyperview users
sharing the same CIU connection.

2.14.2.2 Managing live data load for blocks in the Watch Window

The Watch Window is easy to use, and easy to abuse. Be aware of how much data you are asking for, and
be especially careful when the Watch Window is closed. Closing Hyperview stops data collection in the
Watch Window but when Hyperview is reopened it starts data collection again without necessarily opening
the Watch Window.

Tips for minimizing your bandwidth needs for live data collected by the Watch Window:

¢ Don't collect data you don't need. Pause data collection by clicking on the green clock k& for blocks
you are not actively trending.

CIUMon [Send/=:7.19 Recv/s:5.93] WW Data Files [8561M] |55}

¢ Be aware of the Send/s and Recv/s fields in the Live Data Status Bar at the bottom of the
Hyperview browser. These indicate how many data requests Hyperview is making per second, and
how many data updates it is receiving.

¢ Be aware that the Watch Window will collect data even if it is not open.

MEEFC_04 117.266
MAJID01 1,20,02 B 7299
FILTER FT01  GLYCOL DEHYDR

¢ The default update interval for Watch Window blocks is 10 seconds. Increase the update interval if
you don't need that level of detail in your data. You can change the update interval by editing this
field in the block list to the right of the plots: 23],

2.14.3 How to tell how much data is being requested (Live Data Status Bar)

ClUMon [Send/=:7.19 Recv/:5.93] WW Data Files [8561M] |55

In Hyperview you are now able to tell how much live data a particular Hyperview is requesting per second.
This information in the lower right-hand corner of the Hyperview browser is visible at all times in the status
bar at the bottom of the Browser, and shows you exactly what data fetch load you are placing on the system.
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The Send/s field shows how many requests Hyperview is making per second, from all sources (Watch
Window, Live Loop Annotations, and live data directly on documents), while the Recv/s field shows how
much data is actually being received from the CIU or serial port module. If the send rate is approaching the
system data rate constraint (10-20 values per second per CIU), you need to take steps to reduce the data
load in order to avoid performance degradation.

Keep in mind that the load from all Hyperview users has to be added together to really know what you can
get from your CIU or ClUs.

For a global picture of data load, including requests from all Hyperviews and any other applications
requesting data from CIUMon, you can view the CIUMon statistics. Using CIUMon options, or using
ClUMonController.exe for CIUMon installed as a service, you can turn on statistics showing who is asking for
data, and how much data they are trying to get. This can help a lot in sorting out the load on the system.
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2.15 Hyperview Keyboard Shortcuts

Topic display
T (or A) Toggle attributes/tag names
S Toggle specs
Vv Toggle Vegas Lights

Pane display

J
F

Move window divider

Toggle full screen mode

Display CUrl+E  Toggle error markers Document rotation (PDF, AutoCAD,
MicroStation
Ctrl+Tab Highlight hotspots ) _
R Rotate counterclockwise
F5 Refresh _
. Shift+R Rotate clockwise
Esc  Abort Draw Operation
Changing location Zoom
Backspace Back + Zoom in
Shift+ - Zoom out
Forward
Backspace Z  Toggle zoom
Alt+Home Home
B Next topic in group Table of contents
Shift+B  Previous topic in group Y  Synchtable of contents
L Next index entry Cc Top level table of contents
o Shift+L  Previous index entry CtrlaT '099le Treeview mode table of
Navigation N Next topic with search hits contents
Previous topic with search
Shift+N hits P Projects and windows
] ] Ctrl+O Open Project File
H Next search result in topic
. . . . Ctrl+N New window
Shift+H Previous search result in topic
Ctrl+G  Find coordinates
Focus
Move focus to next
pane/window
Tools Tool windows Search
w Watch Window Ctrl+F Full text search
E Error Browser Alt+D Database search
X Cross Reference Window Alt+T Topic title search
F1 Help
Printing
On-document live data Ctrl+P  Print
Turn on or refresh snapshot P Print with last settings

data
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http://wiki.gmcl.internal/w/Searching_document_titles_for_a_topic
http://wiki.gmcl.internal/w/Printing_the_current_topic
http://wiki.gmcl.internal/w/Printing_with_initialized_settings_(Fast_Print)

Shift+M Turn off snapshot data
The clipboard

Ctrl+A Select all

Double M Turn off snapshot data

Bookmarks Ctrl+C Copy
Ctrl+D Define bookmark Ctrl+V Paste

103


http://wiki.gmcl.internal/w/Displaying_live_data_for_all_inputs_and_outputs_on_a_document_in_Slow_Mode
http://wiki.gmcl.internal/w/Displaying_live_data_for_all_inputs_and_outputs_on_a_document_in_Slow_Mode
http://wiki.gmcl.internal/w/Bookmarking_a_selected_topic
http://wiki.gmcl.internal/w/Selecting_all_the_text_in_a_document
http://wiki.gmcl.internal/w/Copying_selected_text_to_the_clipboard

	Table of Contents
	1 DBDOC Introduction
	1.1 DBDOC 11.6
	1.2 What is DBDOC?
	1.3 Who Can Benefit From DBDOC?
	1.4 How Does DBDOC Work?
	1.5 System Overview
	1.6 How is DBDOC Used?
	1.6.1 DBDOC for Troubleshooting
	1.6.2 DBDOC as Documentation
	1.6.2.1 Uses of DBDOC for Documentation
	1.6.2.2 Optional Documentation Extensions to DBDOC

	1.6.3 DBDOC During Development
	1.6.4 DBDOC for Commissioning and Checkout
	1.6.4.1 Experiences with DBDOC for Commissioning and Checkout

	1.6.5 Using DBDOC with a Simulator
	1.6.6 DBDOC as a Training Tool
	1.6.7 DBDOC for Error Detection
	1.6.8 DBDOC as a Portable System
	1.6.9 DBDOC for NERC Compliant Live Data on Business LAN
	1.6.10 DBDOC as a Collaboration Tool
	1.6.11 DBDOC for Console Upgrades
	1.6.12 DBDOC for System Audits


	2 Hyperview Browser
	2.1 How to run Hyperview, load a project file, and get help
	2.1.1 How to Run Hyperview
	2.1.1.1 Starting Hyperview from a desktop shortcut
	2.1.1.2 Starting Hyperview from the Start Menu
	2.1.1.3 Launching an additional Hyperview window
	2.1.1.4 Advanced: Running Hyperview from the command line

	2.1.2 How to load a project file
	2.1.2.1 Opening a specific project file
	2.1.2.2 Opening a recent project file
	2.1.2.3 Advanced: Opening the most recently built project file
	2.1.2.4 Advanced: Associating project files with Hyperview in Windows

	2.1.3 Help and Documentation
	2.1.3.1 How to access the built-in help documentation
	2.1.3.2 Help and tutorials on the GMCL website
	2.1.3.3 Finding the version of Hyperlink that built the current project file
	2.1.3.4 Figuring out what version of Hyperview is running
	2.1.3.5 Other ways of getting help


	2.2 Guide to basic navigation in Hyperview
	2.2.1 Panes in Hyperview
	2.2.1.1 Specifying the pane orientation

	2.2.2 Index pane
	2.2.2.1 Displaying the Table of Contents
	2.2.2.2 Switching between Classic and Treeview Table of Contents
	2.2.2.3 Clicking on hotspots in the index pane
	2.2.2.4 Index navigation

	2.2.3 Content pane
	2.2.3.1 Displaying hotspots
	2.2.3.2 Clicking on a hotspot to see all the uses of a value
	2.2.3.3 Double clicking on a hotspot to go to the source of a value

	2.2.4 Focus for the active window
	2.2.5 Setting a "Home Page" for your index and content panes
	2.2.5.1 Setting your "Home Page" to the current document

	2.2.6 Scrolling
	2.2.6.1 Default mode scrolling
	2.2.6.2 Legacy scroll & zoom mode scrolling

	2.2.7 Zooming
	2.2.7.1 Default mode zooming with the mouse
	2.2.7.2 Legacy scroll & zoom mode zooming with the mouse
	2.2.7.3 Zooming with toolbar buttons or the keyboard
	2.2.7.4 Manually setting the magnification factor

	2.2.8 Using browser history to return to previously viewed documents
	2.2.9 Using bookmarks for quick access to pages of interest
	2.2.9.1 System bookmarks


	2.3 Techniques for tracing inputs and outputs throughout your system
	2.3.1 Overview of signal tracing in Hyperview
	2.3.2 Tracing signals using hotspots and the index pane
	2.3.2.1 Tracing back to the source of a value
	2.3.2.2 Finding and displaying the uses of a value

	2.3.3 Tracing signals using Go To Use, Go To Source, and double-clicking on hotspots
	2.3.3.1 Jumping directly to the source of a value with Go To Source or double-click
	2.3.3.2 Jumping directly to a use of a value with "Go To Use" or double-click


	2.4 Full text, database, or title searches and search result navigation, and finding coordinates
	2.4.1 Searching
	2.4.2 Text and database searches
	2.4.2.1 Using Full Text Search to search your system for a word or phrase
	2.4.2.2 Using Database Search to find particular blocks or tags
	2.4.2.3 Setting search options for text and database searches
	2.4.2.4 Viewing search results for text and database searches
	2.4.2.5 Displaying and stepping through search results using the Hyperview toolbar

	2.4.3 Using the Topic Title Search to jump directly to a topic
	2.4.4 Advanced: Finding a Coordinate

	2.5 Guide to Live Data on Documents
	2.5.1 Live Data Monitoring
	2.5.1.1 Using Slow Mode live data
	2.5.1.2 Getting live data in Continuous mode
	2.5.1.3 Managing the Slow Mode Data Load

	2.5.2 Live Loop Annotations
	2.5.3 Creating a Live Loop Annotation
	2.5.3.1 Block Options (for either Live Loop Annotations or Watch Window Blocks)
	2.5.3.1.1 Basic Options
	2.5.3.1.2 Annotation Options
	2.5.3.1.3 Watch Window Options
	2.5.3.1.4 Plot or Dynamic Bar Range

	2.5.3.2 Reading Live Loop Annotations
	2.5.3.3 Managing Live Loop Annotations
	2.5.3.4 Moving Live Loop Annotations
	2.5.3.5 Deleting Live Loop Annotations

	2.5.4 Live Specs

	2.6 Trending Live Data in the Watch Window
	2.6.1 Watch Window Overview
	2.6.1.1 Using the Watch Window: quick summary

	2.6.2 Opening the Watch Window
	2.6.3 Adding blocks to the Watch Window so they can be plotted
	2.6.4 Defining and editing block plots in the Watch Window
	2.6.4.1 Specific Watch Window Options

	2.6.5 Creating groups of blocks in the Watch Window
	2.6.5.1 Importing a list of blocks from CIULink
	2.6.5.2 Managing groups of blocks

	2.6.6 Watch Window Highlights
	2.6.7 Timestamp Navigation
	2.6.8 Data Marker Navigation
	2.6.9 Managing Watch Window related bandwidth, and disk usage
	2.6.9.1 Bandwidth
	2.6.9.2 Memory
	2.6.9.3 Disk Usage

	2.6.10 Importing data into other applications

	2.7 Viewing and Managing System Errors with the Error Browser
	2.7.1 Error Browser Overview
	2.7.2 Opening the Error Browser
	2.7.3 Marking errors as Starred, Reviewed or Hidden
	2.7.3.1 Marking individual errors
	2.7.3.2 Marking selected errors

	2.7.4 Filtering errors
	2.7.5 Grouping errors
	2.7.6 New errors
	2.7.7 Sharing error information with other users

	2.8 Customizing the Browser Display
	2.8.1 Showing and hiding specs and attributes
	2.8.1.1 Viewing specs on CAD/CLD diagrams
	2.8.1.2 Viewing attributes on CAD/CLD diagrams
	2.8.1.3 Showing live specs on CAD/CLD diagrams

	2.8.2 Highlighting options in Hyperview
	2.8.2.1 Highlighting search hits
	2.8.2.2 Highlighting hotspots
	2.8.2.3 Showing "Vegas Lights"

	2.8.3 Options Menu: Properties for Hyperview
	2.8.3.1 View options
	2.8.3.2 Color options


	2.9 Making Notes on Documents
	2.9.1 Overview of Annotations
	2.9.2 Text Annotations
	2.9.3 Managing Annotations

	2.10 Printing Documents and Groups of Documents
	2.10.1 Printing a single document
	2.10.1.1 Printing options
	2.10.1.2 Fast Print to use your previously defined print settings
	2.10.1.3 Printing selected text

	2.10.2 Marking the current topic for later printing
	2.10.2.1 Marking the current topic for printing
	2.10.2.2 Marking a linked topic for printing

	2.10.3 Using the Mark for Print dialog to print groups of topics
	2.10.3.1 Marking a group of topics for printing
	2.10.3.2 Removing topics or groups of topics from the marked topics list
	2.10.3.3 Other options


	2.11 Sharing Data with Other Hyperview Users
	2.11.1 Overview of User Data Sharing
	2.11.2 Specifying the Shared Data Folder
	2.11.3 Updating your user information
	2.11.4 Specifying what sorts of user data to share with others
	2.11.4.1 Specifying whose data to include by default


	2.12 Tools, Reports and Indexes
	2.12.1 Viewing the resources used in a drawing with the Audit Window
	2.12.2 Using PCU Map to understand interactions among PCUs
	2.12.3 Graphical Block Map: a graphical overview of block usage
	2.12.4 Tag Index: an alphabetical index of all the tags in your system
	2.12.4.1 Using the Tag Index

	2.12.5 Graphics Cross-Reference Window: index of all the graphics that link to and from the graphic, plus included symbols
	2.12.6 Function Code Descriptions and Uses: an index of all the function codes in your system
	2.12.7 Function Block Index: a list of all the function blocks used on a CAD/CLD
	2.12.8 Graph of F(x) (Function Code 1)
	2.12.9 Adapt Block
	2.12.10 Rung Block Display
	2.12.11 AutoCAD and MicroStation

	2.13 Managing Live Loop Connections
	2.13.1 About live data settings
	2.13.2 About the Live Loop Setup dialog
	2.13.3 Choosing a settings list
	2.13.4 Understanding your current live loop settings
	2.13.5 Adding or modifying live loop connections
	2.13.5.1 Adding a connection
	2.13.5.2 Editing a connection
	2.13.5.3 Deleting a connection
	2.13.5.4 Ignoring a connection

	2.13.6 Specifying a non-default local port range
	2.13.7 Adding routing preferences
	2.13.8 Unavailable data
	2.13.9 Status of live data connections
	2.13.10 Compression of Hyperview data requests

	2.14 Managing Live Data Load
	2.14.1 Overview of live data bandwidth limitations when fetching live system data
	2.14.1.1 Constraints on live data fetch rate

	2.14.2 Managing live data load
	2.14.2.1 Managing data load for live data on documents
	2.14.2.2 Managing live data load for blocks in the Watch Window

	2.14.3 How to tell how much data is being requested (Live Data Status Bar)

	2.15 Hyperview Keyboard Shortcuts


